


Chapter 1:
Introduction
SolarWinds Server & Application Monitor (SolarWinds SAM) allows you to create
and monitor your own custom collection of monitored components, providing an
open field of opportunity to the network engineer. It also allows you to create
flexible Application Monitor templates to combine process monitors, port
availability, and performance counters, allowing you to assess the status of every
aspect of your application and the health of the application as a whole.

SolarWinds SAM vs. Orion APM
The SolarWinds family of products (NPM, SAM, and so on) share many common
components, including the engine these products use to function. These common
components are referred to as the Orion Platform.

In an effort to distinguish SAM as a powerful and unique product, we changed the
name of the product from Orion APM to SolarWinds SAM beginning with version
5.0. This name change should not have a large impact on the user's experience;
however, it is worth noting that there may be instances of the words and
acronyms, SolarWinds, Orion, APM, and SAM, where they appear to be
interchangeable.

Be aware of these name changes as you explore the software and this manual:

l The acronym APM has been replaced with, SAM, when referring to this soft-
ware product. There are instances throughout this guide, as well as various
places within the software itself, and on the SolarWinds website, that the
acronym, APM, may still exist. This is intentional and will be found in paths,
variables, and previous versions of the software. While this may be a slight
inconvenience, it is essential to ensure the integrity of an already active
implementation of previous versions of the software.

l The word Orion has been removed when referring to specific SolarWinds
software. For example: Orion APM, Orion NPM, and so on.

l The word Orion refers to shared platform items such as alerts, shared com-
ponents, variables, and so on.
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Chapter 1: Introduction

Changes in this Guide from SAM 6.0 to 6.1
l AppInsight for Exchange chapter added.
l Windows Scheduled Task Monitor chapter added.
l Web Service Monitoring section added.
l Understanding Sustained Thresholds section added.
l SolarWinds SAM Charts chapter has been added.
l Monitoring Clusters with AppInsight for SQL has been added.
l Both online and offline help files have been upgraded to an improved sys-
tem.

l How To...section added to the Help files.
l Creating a Scheduled Report
l Documentation for the desktop version of the Report Scheduler has been
removed.

l Minor note added to SSL Certificate Expiration Date Monitor.
l Minor note added to SQL Event Log Message Details page.
l Minor note added toWQL Query section of WMI Monitor
l AppInsight Applications chapter reorganized.
l The following templates were added to the Template Reference guide and
remain on thwack.com:

l Microsoft IIS SMTP Server
l Microsoft System Center Configuration Manager 2012
l Microsoft System Center Operations Manager 2012 (Management
Server)

l Microsoft System Center Operations Manager 2012 (Agent)
l Exchange 2013 Client Access Role Services and Counters (Basic)
l Exchange 2013 Client Access Role Counters (Advanced)
l Websense Web Security
l Microsoft DirectAccess 2008 R2
l Microsoft DirectAccess 2012
l Microsoft DirectAccess 2012 (Health with PowerShell)
l Oracle Automatic Storage Management
l SolarWinds Web Performance Monitor (WPM) Player
l BizTalk Server 2010-2013 Message Box and Orchestrations Per-
formance Counters

l BizTalk Server 2010-2013 Host Throttling Performance Counters
l BizTalk Server 2010-2013 Adapters Performance Counters
l BizTalk Server 2010-2013 Availability Status
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Applications Defined
An application in SolarWinds SAM is considered a collection of component
monitors housed in a template. A component monitor is defined as a value
returned by a specific process, counter, status, or a value returned by a script.
With this received data, SolarWinds SAM can easily show you a myriad of vital
statistics concerning the health of your system.

Templates provide blueprints for the applications to be monitored. You can
quickly and easily customize numerous templates, using only the component
monitors you need for a specific environment. Take a look at the following
diagram:

Template/Application Relationship

The following illustration explains the Template and Application relationship and
is true for all templates, including AppInsight for SQL.

Here you can see that if you change something at the template level, the
applications based on that template will be affected. Conversely, if you change
something on the application level, only the individual application will be affected.

This inheritance relationship is beneficial if you need to make a great deal of
changes quickly. For example, rather than change one item on 100 applications
that are based on a single template (which requires 100 changes), you can more
easily change the one item on the template. That one change in the template will
trickle down to all 100 applications that are based on the template.
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SolarWinds SAM recognizes and answers the complexity of today’s business
applications with scalability, flexibility, and reliability.

Refer to the following sections for more information:

l SAM Glossary of Terms
l How Does SolarWinds Server & Application Monitor Work?

SAM Glossary of Terms
Here is a list of fundamental terms with which you should be familiar. A tree-like
map is also provided to visualize how SAM operates.

92



Component Monitor – A component monitor is the fundamental element of an
application. Component monitors return the current status or value of a monitored
service or process. All component monitors return at least one value or one status
condition.

Node - A node is considered to be any endpoint of a given network. For example,
any server or computer on a network is considered a node. Sometimes a node is
referred to as a device.

Application - An application in SolarWinds SAM is a collection of component
monitors.

Template - A template is the blueprint for an application. It is a collection of
component monitors designed to monitor a server or application. You can
customize numerous templates using only the component monitors you need for a
specific environment.

The type of information returned by the component monitor is based upon the type
of monitor being utilized. For example, one type of monitor can report the up or
down status of a service or process, another monitor can return the percentage of
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Chapter 1: Introduction

free space of a volume. Another type of component monitor can return up to ten
values. Each monitor type, along with its parameters and returned values and/or
states, is unique.

Each node, along with its applications and component monitors, can be viewed
from the SolarWinds SAM web console as shown in the diagram below. The view
can be customized to suit your needs.

How Does SolarWinds Server & Application Mon-
itor Work?
Using UDP, TCP, SNMP, and WMI calls to your network framework and
application servers, SolarWinds Server & Application Monitor provides real time
feedback on your applications and trending through statistics stored in the

94



SolarWinds database. Keeping with the SolarWinds common components
infrastructure, there are no agents installed on your servers and no remote
software to maintain. All calls are made in real time and displayed on a Web
Console accessible from any supported browser.

As a standalone product, SAM's operations can be visualized with the following
flowchart:

Installed as a module in your family of SolarWinds products, SAM can be
visualized with the following flowchart:

95

How Does SolarWinds Server & Application Monitor Work?



Chapter 1: Introduction

Application Availability and Status
On any given poll, an application’s availability is either 100% or 0% based on the
status of the application. Availability is 100% if the application status is available,
warning, or critical. For any other status on that poll, SAMmarks the availability at
0%. 

The status of an application is determined by the worst status of the individual
component monitors for that application.  For example, if one component for an
application is down, then the application is marked as down. If one component is
in a warning state and the rest of the components are up, then the application is
given a warning status.
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With respect to how an application’s availability is calculated over time, SAM
aggregates the availability values to Hourly/Daily tables during database
maintenance, which is how the average is calculated.  Availability for component
monitors is calculated in the same way.
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Chapter 2:
Requirements and Installation
Installing SolarWinds Server & Application Monitor (SolarWinds SAM) is a wizard
driven process. Resource and space requirements are reasonable, and most
deployments do not require hardware updates to your SolarWinds Server.

This chapter discusses:

l Requirements for SolarWinds SAM
l FIPS Support
l Server Sizing
l SNMP Requirements for Monitored Devices
l Upgrading SolarWinds Server & Application Monitor
l Installing SolarWinds Server & Application Monitor
l Activating Your License
l Finishing SolarWinds SAM Installation
l Excluding SolarWinds Data Directories from Anti-Virus Scanning
l Running SolarWinds SAM
l Internet Explorer Security Settings
l Licensing

Requirements for SolarWinds SAM
SolarWinds recommends installing your SolarWinds product on one server, and
installing the SolarWinds database on its own SQL Server. Installations of
multiple SolarWinds SAM servers using the same database are not supported.

SolarWinds Server Software Requirements

The following table lists minimum software requirements and recommendations
for your SolarWinds server.

Software Requirements

Operating
System

Windows Server 2003, Windows Server 2008 R2, with IIS in
32-bit mode, Windows 2012, or Windows 2012 Datacenter
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edition. IIS must be installed. SolarWinds recommends that
SolarWinds administrators have local administrator privileges to
ensure full functionality of local SolarWinds tools. Accounts
limited to use of the SolarWinds Web Console do not require
administrator privileges.

Notes:
l SolarWinds does not support production installations of
SolarWinds products on Windows XP, Windows Vista,
or Windows 7 systems.

l If you are installing SolarWinds SAM on Windows
Server 2003, confirm that your full computer name is no
longer than 15 characters in length. Windows Server
2003 trims any characters beyond the fifteenth, and this
may prevent SolarWinds services from properly identi-
fying your SolarWinds server.

l For more information, see “Additional SolarWinds SAM
Requirements” on page 103.

Web
Server

Microsoft IIS, version 6.0 and higher, in 32-bit mode.

DNS specifications require that hostnames be composed of
alphanumeric characters (A-Z, 0-9), the minus sign (-), and periods
(.). Underscore characters (_) are not allowed. For more
information, see RFC 952.

Warning: The following Windows accounts, as configured by IIS
6.0 on Windows Server 2003 with their default security settings,
are required:

IUSR_<hostname>, as a member of the Guests group ONLY.

IWAM_<hostname>, as a member of the IIS_WPG group ONLY.

Disabling these accounts or changing any default settings of
these accounts may negatively affect the operation of your
SolarWinds installation. SolarWinds strongly recommends
against altering these accounts or their settings.

Note: SolarWinds neither recommends nor supports the
installation of any SolarWinds SAM product on the same server
or using the same database server as a Research in Motion
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(RIM) Blackberry server.

.NET
Framework

Version 3.5 .NET Framework, 4.0 is recommended.

SNMP
Trap
Services

Windows operating system management and monitoring tools
component

Web
Console
Browser

Microsoft Internet Explorer version 7 or higher with Active
scripting,

Firefox 13.0 or higher (Toolset Integration is not supported on
Firefox),  Google Chrome

SolarWinds Server Hardware Requirements

The following table lists minimum hardware requirements and recommendations
for your SolarWinds server.

Note: Hardware requirements are listed by SolarWinds license level.

Hardware AL50 - AL500 AL700 – AL1500 ALX

CPU
Speed

2.4 GHz Dual Core 3.0 GHz Quad Core 3.0 GHz

Note: Dual processor, dual core is recommended.

Hard Drive
Space

4 GB 10 GB 25 GB

Note: A RAID 1 drive for server operating system, SolarWinds
installation, and tempdb files is recommended. The SolarWinds
installer needs 1GB on the drive where temporary Windows
system or user variables are stored. Per Windows standards, some
common files may need to be installed on the same drive as your
server operating system.

Memory 4 GB 6 GB 8 GB

Application
Ports

161/SNMP and 443/SNMP. VMware ESX/ESXi Servers are polled
on 443.
17777/TCP open for SolarWinds module traffic

17778/ HTTPS open to access the SolarWinds Information Service
API
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Requirements for Virtual Machines and Servers

SolarWinds installations on VMware Virtual Machines and Microsoft Virtual
Servers are fully supported if the following minimum configuration requirements
are met for each virtual machine.

Note: SolarWinds strongly recommends that you maintain your SQL Server
database on a separate physical server.

Virtual
Machine
Configuration

SolarWinds Requirements by License Level

AL50 - AL500 AL700 - AL1500 ALX

CPU Speed 2.4 GHz Dual Core 3.0 GHz Quad Core 3.0
GHz

Allocated
Hard Drive
Space

4 GB 10 GB 25 GB

Note: Due to intense I/O requirements, SQL Server should be
hosted on a separate physical server configured as RAID 1+0.
RAID 5 is not recommended for the SQL Server hard drive.

Memory 4 GB 6 GB 8 GB

Network
Interface

Each virtual machine on which SolarWinds is installed should
have its own, dedicated network interface card.

Note: Since SolarWinds uses SNMP to monitor your network,
if you are unable to dedicate a network interface card to your
SolarWinds server, you may experience gaps in monitoring
data due to the low priority generally assigned to SNMP
traffic.

Requirements for the SolarWinds Database Server (SQL Server)

The following table lists software and hardware requirements for your SolarWinds
database server. SolarWinds license levels are provided as a reference.

Requirements AL50 - AL700 - ALX
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AL500 AL1500

SQL Server SQL Server 2005 SP1 Express, Standard, or Enterprise
(Important: Not supported in SAM 6.1+.)
SQL Server 2008 Express, Standard, or Enterprise

SQL Server 2012

Notes:
l Due to latency effects, SolarWinds does not recom-
mend installing your SQL Server and your
SolarWinds server or additional polling engine in dif-
ferent locations across a WAN. For more inform-
ation, see SolarWinds Knowledge Base article, “Can
I install my SolarWinds server or Additional Polling
Engine and my SolarWinds database (SQL Server)
in different locations across a WAN?”

l Either mixed-mode or SQL authentication must be
supported.

l If you are managing your SolarWinds database,
SolarWinds recommends you install the SQL Server
Management Studio component.

l Use the following database SQL statement to check
your SQL Server version, service pack or release
level, and edition:

select SERVERPROPERTY ('productversion'), SERVERPROPERTY
('productlevel'), SERVERPROPERTY ('edition')

CPU Speed 2.4 GHz Dual Core
3.0 GHz

Quad Core 3.0 GHz
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Hard Drive
Space

4 GB 10 GB 25 GB

Note: Due to intense I/O requirements, a RAID 1+0 drive is
strongly recommended the SQL Server database and
SolarWinds data and log files. RAID 5 is not recommended
for the SQL Server hard drive. The SolarWinds installer
needs at least 1GB on the drive where temporary Windows
system or user variables are stored. Per Windows standards,
some common files may need to be installed on drive as your
server operating system.

Memory 4 GB 6 GB 8 GB

Note: SolarWinds recommends additional RAM for
SolarWinds SAM installations utilizing more than 1,000
monitors. For optimal performance in larger ALX
environments, we recommend 8GB of RAM or greater.
Additional memory will improve both performance and
reliability.

Memory and
Additional
Pollers

Each additional poller requires 8GB of
additional RAM. For example, SAM plus 2
additional pollers would require 24GB of
RAM. 3 additional pollers would require
32GB of RAM, and so on.

PowerShell PowerShell 2.0 must be installed on the
SAM server for versions 5.5+.

The Configuration Wizard installs the following required x86 components if they
are not found on your SolarWinds database server:

l Microsoft SQL Server Native Client
l Microsoft SQL Server Management Objects

Additional SolarWinds SAM Requirements

Enterprise-level SolarWinds SAM deployments with the potential for more than
1,000 monitors may need additional computing resources above the standards
required for SolarWinds common components:
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Component Monitors Additional Requirements

Up to 1,000 No additional requirements

More than 1,000 8+ GB RAM

Important: If you are running Windows Server 2008, you must upgrade to
Windows Server 2008 R2 because SolarWinds SAM does not support Windows
Server 2008 due to known WMI issues.

FIPS Support
FIPS (Federal Information Processing Standard) defines security and
interoperability standards for computers used by the U.S. federal government.

To enable FIPS in the Local Security Policy on Windows:
1. Click Start > Control Panel > System and Security > Administrative Tools,

and then double-click Local Security Policy.
2. Expand the Local Policies category in the left pane, and then click Security

Options.
3. Right-click System Cryptography: Use FIPS compliant algorithms for

encryption, hashing, and signing.
4. In the context menu that is displayed, click Properties.
5. In the Local Security Setting tab, click Enabled and then click OK.

Notes:
l FIPS can also be enabled as part of Group Policy.
l If using the FIPS Manager to enable/disable FIPS, you need to restart your
web browser to apply the new settings.

SolarWinds SAM installations on Windows Server 2008 R2 require a Microsoft
hotfix to realize the FIPS-compatibility features of this release. For more
information about this required Microsoft hotfix, see the article
http://support.microsoft.com/kb/981119. As noted in the KB article, you need to
enable FIPS first before applying the Microsoft hotfix.

If you use component monitors that have not passed FIPS testing, they may not
work properly when FIPS is enabled.

FIPS Manager

SolarWinds does provide a FIPS manager. The default location of this program is
C:\Program Files (x86)\SolarWinds\Orion\SolarWinds.FipsManager.exe.
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The FIPS Manager allows you to switch between both Windows and SolarWinds 
FIPS compatible mode. (FIPS mode in Windows needs to be disabled manually if
needed).

The following SolarWinds SAM component monitors have passed FIPS testing:

l DHCP User Experience Monitor
l Directory Size Monitor
l DNS Monitor - TCP
l DNS Monitor - UDP
l DNS User Experience Monitor
l Download Speed Monitor
l File Age Monitor
l File Count Monitor
l File Existence Monitor
l File Size Monitor
l FTP Monitor
l HTTP Form Login Monitor
l HTTP Monitor
l HTTPS Monitor
l IMAP4 Monitor
l IMAP4 User Experience Monitor
l LDAP User Experience Monitor
l Linux/Unix Script Monitor
l MAPI User Experience Monitor
l NNTP Monitor
l ODBC User Experience Monitor
l Oracle User Experience Monitor
l Performance Counter Monitor
l POP3 Monitor
l POP3 User Experience Monitor
l Process Monitor - SNMP– FIPS not supported when SNMP is SNMPv3
and using MD5.

l Process Monitor - WMI
l SMTP Monitor
l SNMP Monitor – FIPS not supported when SNMP is SNMPv3 and using
MD5.

l SQL Server User Experience Monitor
l TCP Port Monitor
l Tomcat Server Monitor
l Web Link Monitor
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l Windows Event Log Monitor
l Windows Script Monitor

Server Sizing
SolarWinds SAM is capable of monitoring networks of any size, ranging from
small corporate LANs to large enterprise and service provider networks. Most
SolarWinds SAM systems perform well on 3.0 GHz systems with 4 GB of RAM
using default polling engine settings. However, when monitoring larger networks,
you should give additional consideration to the hardware used and the system
configuration.

There are three primary variables that affect scalability. The most important
consideration is the number of monitored components. Monitoring more than
1,000 components may require fine tuning for optimal performance. The second
variable to consider is polling frequency. For instance, if you are collecting
statistics more frequently than the default, the system will have to work harder and
system requirements will increase. Finally, the number of simultaneous users
accessing SolarWinds SAM directly impacts system performance.

When planning a SolarWinds SAM installation, there are four main factors to keep
in mind with respect to polling capacity: CPU, memory, number of polling
engines, and polling engine settings. For minimum hardware recommendations,
see “Requirements for SolarWinds SAM” on page 98. For more information about
polling engines, see “Additional Polling Engine and Web Console” on page 930.

Installing SolarWinds SAM and SQL Server on different servers is highly
recommended, particularly if you are planning on having more that 1,000
component monitors. This scenario offers several performance advantages as the
SolarWinds SAM server does not perform any database processing and it does
not have to share resources with SQL Server.

If you plan to monitor 10,000 or more components, SolarWinds recommends that
you install additional polling engines on separate servers to help distribute the
work load. For more information about sizing SolarWinds SAM to your network,
contact the SolarWinds sales team or visit www.solarwinds.com. For more
information about configuring additional pollers, see “Additional Polling Engine
and Web Console” on page 930.
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SNMP Requirements for Monitored Devices
SolarWinds SAM can monitor the performance of any SNMPv1-, SNMPv2c-, or
SNMPv3-enabled device on your network. Consult your device documentation or
a technical representative of your device manufacturer to acquire specific
instructions for configuring SNMP on your device.

Notes:
l To properly monitor devices on your network, you must enable SNMP on all
devices that are capable of SNMP communications.

l Unix based devices should use the configuration of Net-SNMP version 5.5
or higher that is specific to the type of Unix-based operating system in use.

l SolarWinds SAM is capable of monitoring VMware ESX and ESXi Servers
versions 3.5 and higher with VMware Tools installed. For more information
about enabling SNMP and VMware Tools on your VMware device, consult
your VMware documentation or technical representative.

l If SNMPv2c is enabled on a device you want to monitor, by default,
SolarWinds SAM will attempt to use SNMPv2c to poll the device for per-
formance information. If you only want SolarWinds SAM to poll using
SNMPv1, you must disable SNMPv2c on the device to be polled.

Enabling Microsoft Internet Information Services
(IIS)
To host the SolarWinds Web Console, Microsoft Internet Information Services
(IIS) must be installed and enabled on your SolarWinds SAM server. Windows
Server 2003 requires IIS version 6 while Windows Server 2008 requires IIS
version 7, as detailed in the following sections:

l Enabling IIS on Windows Server 2003
l Enabling IIS on Windows Server 2008

Enabling IIS on Windows Server 2003
The following procedure enables IIS on Windows Server 2003.

To enable IIS on Windows Server 2003:
1. Click Start > Control Panel > Add or Remove Programs.
2. Click Add/Remove Windows Components.
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3. Confirm that Application Server is checked, and then click Details.

4. Confirm that Internet Information Services (IIS) is checked, and then click
Details.
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5. Confirm thatWorld Wide Web Service is checked, and then click Details.

6. Confirm thatWorld Wide Web Service is checked, and then click OK.

7. Click OK on the Internet Information Services (IIS) window, and then
click OK on the Application Server window.
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8. ConfirmManagement and Monitoring Tools is checked and click
Details.

9. Confirm that both Simple Network Management Protocol andWMI
SNMP Provider are checked, and then click OK.

10. Click Next, and then click Finish when the wizard completes.
Note: You may be prompted to install additional components, to provide
your Windows Operating System media, or to restart your computer.

Enabling IIS on Windows Server 2008
IIS is enabled automatically after the SAM installation and prior to the start of the
Configuration Wizard. If the Configuration Wizard detects that IIS is not installed
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on Windows 2008, it installs IIS. The following manual procedure is provided for
Windows Server 2008 in case problems occur with the automatic IIS installation.

To enable IIS on Windows Server 2008:
1. Click Start > All Programs > Administrative Tools > Server Manager.
2. Click Roles.

3. Click Add Roles.

4. Click Next to start the Add Roles Wizard, and then checkWeb Server
(IIS).
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5. If you are prompted to add features required for Web Server (IIS), click
Add Required Features.

6. Click Next on the Select Server Roles window, and then click Next on the
Web Server (IIS) window.

7. Confirm that Common HTTP Features > Static Content is installed.
8. Check Application Development > ASP.NET.
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9. Click Add Required Role Services.

10. Check both Security > Windows Authentication and Security > Basic
Authentication.
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11. Check Management Tools > IIS 6 Management Compatibility.

12. Click Next on the Select Role Services window.
13. Click Install on the Confirm Installation Selections window.
14. Click Close on the Installation Results window.
15. If you are currently enabling IIS as part of a SolarWinds SAM install-

ation, restart the SolarWinds SAM installer.

Upgrading SolarWinds Server & Application Mon-
itor
If you have version 3.1 or lower of SolarWinds APM installed, you must first
upgrade to NPM 10 and then upgrade to APM 3.5 before you can upgrade to
SAM 5.X. For more information, click Upgrade Instructions in any SolarWinds
NPM group on the License Management page of the Customer Portal.

Note: SolarWinds recommends creating a backup of your database before
starting any SolarWinds upgrade or installation.

If you have version 3.5 or later of APM installed, you have an option for
upgrading to APM 4.X, or SAM 5.X:

Upgrading NPM and SolarWinds SAM on Your Current Server
Notes:

l Upgrading from SAM 5.5 to 6.1 is supported.
l Always upgrade NPM first, then you can upgrade to SAM
l If installed together on the same server, SAM and SolarWinds NPM share
the same database.
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l If installed on different servers, SAM and SolarWinds NPM each require
their own database. You cannot share one database between separate
SAM and SolarWinds NPM servers.

Upgrading NPM and SolarWinds SAM on Your Current Server
To upgrade both SolarWinds NPM and SolarWinds SAM on your current
SolarWinds server:

1. Upgrade SolarWinds NPM to version 10.3.
Note: For compatablitiy between specific versions of SolarWinds software,
refer to the following KB article: http://-
know-
ledgebase.solarwinds.com/kb/questions/1888/Compatibility+of+SolarWinds+Orion+Products+for+Installation+and+Upgrade

2. Install SAM 5.X as described in the section “Installing SolarWinds Server &
Application Monitor ” on page 133.

Important: Always upgrade NPM on all SolarWinds servers first. After that is
complete, you can successfully upgrade. Failure to upgrade in the correct order
will result in the Configuration Wizard generating a Database Configuration
Failure error.

For more information, see “Installing SolarWinds Network Performance Monitor”
in the SolarWinds Network Performance Monitor Administrator Guide.

Upgrading SAM to a New Server While Keeping NPM on Your Cur-
rent Server
To upgrade SAM to a new server:

1. Back up your current SolarWinds Server.
2. Shutdown SolarWinds NPM and SAM on your current SolarWinds Server.
3. Have your Database Administrator clone your SolarWinds database to a

different name.
Note: To clone your SolarWinds database, use the appropriate version of
Microsoft SQL Server Management Studio for your database. You can
download this from the Microsoft website if it is not already installed.

4. Uninstall SAM from your original SolarWinds Server.
a. Use Add or Remove Programs in Control Panel to remove

SolarWinds Server & Application Monitor.
b. The Configuration Wizard should be run automatically as part of the

uninstallation. If it is not, execute it manually by clicking Start > All
Programs > SolarWinds Orion > Configuration and Auto-
Discovery > Configuration Wizard.
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c. In the Configuration Wizard, select all components to be modified:
Database,Website, and Services, and then configure them appro-
priately for your original SolarWinds Server.

d. Ensure that you specify the original database.
e. Delete the SAM folder in the <drive>:\INETPUB\SOLARWINDS\ORION

directory, where <drive> is the drive letter for the SAMWebsite Root
Directory, for example: C.

5. Copy the security certificate from the original server to the new server.
6. Install SAM on its new server as described in the section “Installing

SolarWinds Server & Application Monitor ” on page 133, and in the Con-
figuration Wizard specify the new cloned database.

For more information, see “Installing SolarWinds Server & Application Monitor ”
on page 133.

Moving SolarWinds SAM to a different server
Migrating SolarWinds SAM to a different server is a process that can take as little
as 30 minutes or as long as several hours, depending on the size of your
SolarWinds database. Consider scheduling an appropriate maintenance window
in which to perform your migration. The process involves deactivating the
licenses of your products, stopping the services, migrating the products, and then
uninstalling your previous installation.

General Requirements
Moving your SolarWinds SAM implementation to a new server requires the
following:

l Server hardware meeting minimum requirements for the new
SolarWinds SAM implementation.

l Windows user account credentials that have been granted administrative
rights on both servers.

l A license reset to register SolarWinds SAM on your new server. You will
need to install SolarWinds License Manager to manage the required
license migration.

Note:Maps and map objects created or edited in SolarWinds Network Atlas are
stored in the SolarWinds database. If the database is successfully migrated, there
is no need to migrate any additional Network Atlas map files.
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Database Requirements
Ensure that you comply with the following requirements before you attempt to
modify or back up your existing database:

l SolarWinds APM version 4.0 and higher requires SQL Server 2005 SP1 or
later, including SQL Server 2008.

l Install your new database server. The following procedures assume you
are moving your database from one physical server to another and that the
management tool (Enterprise Manager, SQL Server Management Studio
Express, or SQL Server Management Studio) is installed on the new data-
base server.

l If you want to use a Microsoft SQL Server Express database, recognize
that the database store is limited to 4GB.

l Know the sa password to both your existing SolarWinds database server
and your new database server.

l Know the credentials to an account with administrator rights on both your
existing SolarWinds database server and your new database server.

l Have a maintenance window during which you can safely shutdown your
SolarWinds SAM services. You need to stop data collection to ensure that
your backup file matches your last active database state.

Stopping SAM Services
It is important to stop the SolarWinds SAM services that are currently writing to the
database. This ensures that you do not have data inconsistencies when you bring
your new database server online.

To stop SolarWinds SAM services:

1. Click Start > All Programs > SolarWinds Orion > Advanced Features >
Orion Service Manager.

2. Expand Services.
3. Click each service, except the SQL Server service, and then click Stop.

Notes:
l If you have more than one Polling Engine, you will need
to stop each additional Polling Engine before continuing.

l Do not stop the SQL Service. The SQL Service needs to
be running in order to make the necessary changes to
the database.

4. Click File > Exit.
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Creating a Database Backup File with Database Manager
Complete the following procedure if you want to use Database Manager.

To backup your SolarWinds database using Database Manager:

1. Log on to the computer that hosts your current SolarWinds SAM server.
2. Click Start > All Programs > SolarWinds Orion > Advanced Features >

Database Manager.
3. If your SQL Server is not listed in the left pane, add your server, as

shown in the following steps:
a. Click Add Server.
b. Select the name of the SQL instance from the SQL Server list. If

your server is not listed, type the name or IP address.
c. Select the appropriate authentication type, and then click Connect

to Database Server.
4. Locate and right-click your database in the Database Manager tree in the

left pane, and then click Backup Database.
5. Type a Description of the database backup, and then specify a Backup

Filename, including the path.
Note: Click the ellipsis to directly select the Backup Filename.

6. Select either of the following options:
l If you want to attach your new database backup to the end of the
selected backup file, select Append to the end of the Backup File.

l If you want to overwrite the selected backup file, selectOverwrite
Backup File.

7. Click OK.
8. If you are moving the SQL database to the new SolarWinds SAM

server, copy the new backup file to a folder on the new server.
9. Install SolarWinds SAM on the new server, but DO NOT run the Con-

figuration Wizard yet. Reboot the server if prompted, and then register the
software.
Note: A new license key is required, and you will need to install
SolarWinds License Manager to manage the required license migration.

10. On the new server, click Start > SolarWinds Orion > Advanced
Features > Database Manager.

11. If your SQL Server is not listed in the left pane, add your server, as
shown in the following steps:
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1. Click Add Server.
2. Select the name of the SQL instance from the SQL Server list. If

your server is not listed, type the name or IP address.
3. Select the appropriate authentication type, and then click Connect

to Database Server.
12. Locate and right-click on your server in the Database Manager tree in the

left pane, and then click Connect to Server.
13. If you moved the SQL database to the new server, perform the following

steps:
Note: Database Manager cannot create new folders. Therefore, specify a
path that already exists.
a. Click Database > Restore Database.
b. Click the ellipsis to Select the Database file to Restore.
c. If you want to verify the validity of the selected database, click

Verify.
d. Confirm or edit the name of the restored database in the Restore Data-

base as the following Database name field.
e. If you want to restore the database as .MDF or .LOG files, provide appro-

priate filenames in the Restore Database in the following MDF and
LOG files fields.

f. Click OK.
14. Run the Configuration Wizard and specify the existing (or newly restored)

database on the Database setup section of the wizard. When prompted,
click Yes to use the existing database.
Note: Do not skip tabs or deviate from the tab order. Click Start, and then
click Continue to complete the wizard in order. Completing tabs out of
order may adversely affect the install process.

Creating a Database Backup File with SQL Server Management Stu-
dio Express
Complete the following procedure if your new database server uses SQL Server
2005 Express edition.

To backup your SolarWinds database using SQL Server Management Stu-
dio Express:

1. Log on to the new database server using an administrator account.
2. Click Start > All Programs > Microsoft SQL Server 2005 > SQL Server

Management Studio Express.
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3. Specify the name of the current SolarWinds database server on the Con-
nect to Server window.

4. If you are using SQL Server Authentication, click SQL Server Authentic-
ation in the Authentication field, and then specify your credentials in the
Username and Password fields.

5. Click Connect.
6. Expand the name of your SolarWinds server, and then expand Databases

in the left pane.
7. Right-click the name of your SolarWinds database, and then click Tasks >

Backup.
8. Click Add, and then specify and remember the Destination you provide.

This is the directory and name of your backup.
Note: Remember, this file is created on the remote database server. It is
not created locally.

9. Click Options in the Select a page pane on the left.
10. Check Verify backup when finished.
11. Click OK.
12. Copy the .bak file from your current SolarWinds database server to your

new database server.

Creating a Database Backup File with SQL Server Management Stu-
dio
Complete the following procedure if your new database server uses SQL Server
2005 or 2008.

To backup your SolarWinds database using SQL Server Management Stu-
dio:

1. Log on to the new database server using an administrator account.
2. Click Start > All Programs > Microsoft SQL Server 200X > SQL Server

Management Studio.
3. Specify the server name of the current SolarWinds database server on the

Connect to Server window.
4. If you are using SQL Server Authentication, click SQL Server Authentic-

ation in the Authentication field, and then specify your credentials in the
User name and Password fields.

5. Click Connect.
6. In the pane on the left, expand the name of the server hosting the SQL

instance you are using for SolarWinds SAM, and then expand Databases.
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7. Right-click the name of your SolarWinds database, and then click Tasks >
Back Up.

8. In the Source area, select Full as the Backup type.
9. In the Backup set area, provide an appropriate Name and Description for

your database backup.
10. If there is not already an appropriate backup location listed in the Destin-

ation area, click Add, and then specify and remember the destination path
and file name you provide. This is the location where your backup is
stored.
Note: Remember, if your database is on a remote server, as recom-
mended, this backup file is also created on the remote database server. It
is not created locally.

11. Click Options in the Select a page pane on the left.
12. In the Reliability area, check Verify backup when finished.
13. Click OK.
14. Copy the .bak file from your current SolarWinds database server to your

new database server.

Restoring a Database Backup File for SQL Express Server
Complete the following procedure if you are restoring your SolarWinds database
backup file to a database server running SQL Express Server.

Note: Remember that SQL Express has a 4GB data store limitation. If at all
possible, consider using a production version of SQL Server.

To restore your database backup file on a server running SQL Express
Server:

1. Log on to the new database server using an administrator account.
2. Click Start > All Programs > Microsoft SQL Server 2005 > SQL Server

Management Studio Express.
3. Click File > Connect Object Explorer.
4. Specify the name of the new SolarWinds database server on the Connect

to Server window.
5. If you are using SQL Server Authentication, click SQL Server Authentic-

ation in the Authentication field, and then specify your credentials in the
User name and Password fields.

6. Click Connect.
7. Click the name of your server to view an expanded list of objects asso-

ciated with your server.
8. Click Databases, and then click Restore Database.
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9. Leave To database blank.
10. Click From device, and then browse (…) to the location of your .bak file.
11. Click Add, and then navigate to the .bak file and click OK.
12. Click OK on the Specify Backup window.
13. Check Restore.
14. Select the name of your database from the To database field. It will now

be populated with the correct name.
15. Click Options in the left Select a page pane, and then check Overwrite

the existing database.
16. Ensure you select a directory that already exists for the files listed in the

Restore As column.
17. Click OK.
18. Open and run the configuration wizard to update your SolarWinds SAM

installation.

Restoring a Database Backup File for SQL Server 2005
Complete the following procedure if you are restoring your SolarWinds database
backup file to a database server running SQL Server 2005.

To restore your database backup file on a server running SQL Server 2005:

1. Log on to the new database server using an administrator account.
2. Click Start > All Programs > Microsoft SQL Server 2005 > SQL Server

Management Studio.
3. Click File > Connect Object Explorer.
4. Specify the name of the new SolarWinds database server on the Connect

to Server window.
5. If you are using SQL Server Authentication, click SQL Server Authentic-

ation in the Authentication field, and then specify your credentials in the
User name and Password fields.

6. Click Connect.
7. Click the name of your server to view an expanded list of objects asso-

ciated with your server, and then right-click Databases.
8. Click Restore Database.
9. Leave To database blank.
10. Click From device, and then browse (…) to the location of your .bak file.
11. Click Add, and then navigate to the .bak file and then click OK.
12. Click OK on the Specify Backup window.
13. Check Restore.
14. Select the name of your database from the To database field. It will now be

populated with the correct name.
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15. Click Options in the left Select a page pane.
16. Check Overwrite the existing database.
17. For each Original File Name listed, complete the following steps to ensure

a successful restoration:
a. Click Browse (…).
b. Select a directory that already exists.
c. Provide a name for the Restore As file that matches the Original File

Name, and then click OK.
18. Select Leave the database ready to use by rolling uncommitted trans-

actions…(RESTORE WITH RECOVERY).
19. Click OK.
20. Open and run the configuration wizard to update your SolarWinds SAM

installation.
Note: Due to the nature of security identifiers (SIDs) assigned to SQL
Server 2005 database accounts, SolarWinds recommends that you create
and use a new account for accessing your restored SolarWinds database
on the Database Account window of the SolarWinds Configuration Wizard.

Restoring a Database Backup File for SQL Server 2008
Complete the following procedure if you are restoring your SolarWinds database
backup file to a database server running SQL Server 2008.

To restore your database backup file on a server running SQL Server 2008:

1. Log on to the new database server using an administrator account.
2. Click Start > All Programs > Microsoft SQL Server 2008 > SQL Server

Management Studio.
3. Click File > Connect Object Explorer.
4. Specify the name of the new SolarWinds database server on the Connect

to Server window.
5. If you are using SQL Server Authentication, click SQL Server Authentic-

ation in the Authentication field, and then specify your credentials in the
User name and Password fields.

6. Click Connect.
7. Click the name of your server to view an expanded list of objects asso-

ciated with your server, and then right-click Databases.
8. Click Restore Database.
9. Leave To database blank.
10. Select From device, and then click Browse (…).
11. Confirm that File is selected as the Backup media.
12. Click Add.
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13. Navigate to the .bak file, select it, and then click OK.
14. Click OK on the Specify Backup window.
15. In the Destination for restore area, select the name of your database from

the To database field.
Note: The To database is now populated with the correct name.

16. Check Restore next to the database backup you are restoring.
17. Click Options in the left Select a page pane.
18. Check Overwrite the existing database (WITH REPLACE).
19. For each Original File Name listed, complete the following steps to ensure

a successful restoration:
a. Click Browse (…).
b. Select a directory that already exists.
c. Provide a name for the Restore As file that matches the Original File

Name, and then click OK.
20. Select Leave the database ready to use by rolling uncommitted trans-

actions…(RESTORE WITH RECOVERY), and then click OK.
21. Open and run the configuration wizard to update your SolarWinds SAM

installation.
Note: Due to the nature of security identifiers (SIDs) assigned to SQL
Server 2008 database accounts, SolarWinds recommends that you create
and use a new account for accessing your restored SolarWinds database
on the Database Account window of the SolarWinds Configuration Wizard.

Updating SolarWinds SAM to Use the New Database Server
In general, SolarWinds recommends that you use SQL Server Authentication with
the sa login and password to ensure that SolarWinds SAM can always access
your SQL Server database, even when it is hosted remotely on a separate server.

To update SolarWinds SAM to use a new database:

1. Log on to your SolarWinds SAM server.
2. Click Start > All Programs > SolarWinds Orion > Configuration and

Auto-Discovery > Configuration Wizard.
3. Check Database, and then click Next.
4. Specify your new database server in the SQL Server field.
5. If you want to use SQL authentication, check Use SQL Server Authentic-

ation, and then provide the appropriate credentials.
Note: SolarWinds recommends that you use the sa login and password for
your database server to ensure that you are able to properly configure the
SolarWinds database user account.
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6. Click Next.
7. Select Use an existing database, select or type the Existing Database

name, and then click Next.
8. If you are prompted to use the existing database, click Yes.
9. Select Create a new account, and then provide a New Account name.

Notes:
l Creating a new account ensures that SolarWinds SAM has required
access to your migrated database.

l The New Account must be a member of the securityadmin server
role.

l The sysadmin role and the sa user account are always members of
securityadmin.

10. Provide and confirm an account Password.
11. Click Next to start database configuration, and then click Finish to exit the

Configuration Wizard.

Reassigning Nodes
If a new name is used for the new SolarWinds SAM server, it is added to the
database as a new polling engine. All current nodes remain assigned to the old
polling engine name and must be reassigned to the new polling engine, as
shown in the following procedure.

To reassign items to the new polling engine:

1. Click Start > All Programs > SolarWinds Orion > Advanced Features >
Orion Service Manager.

2. Stop all SolarWinds services.
Notes:

l If you have more than one Polling Engine, you will need to stop
each additional Polling Engine before continuing.

l Do not stop the SQL Service. The SQL Service needs to be running
in order to make the necessary changes to the database.

3. Click File > Exit
4. Click Start > SolarWinds Orion > Database Utilities > Database Man-

ager.
5. Expand your SQL Server in the tree.
6. Expand the SolarWinds database.

Note: By default, this database is named NetPerfMon.
7. Right-click on the Engines table, and then click Query Table.
8. Click Refresh to display the table entries.
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9. Select Read-Write (Results can be edited).

10. Replace the value in the ServerName field for the old polling engine with
the server name of the new polling engine. In the previous graphic, the
OLD-SERVER is renamed NEW-SERVER.
Note: It is not necessary to update the IP field. The next time the service is
started, SolarWinds SAM discovers the new IP address, and the IP field is
updated automatically.

11. Delete the newly added engine from the table (EngineID: 2 in this
example) by clicking on the blank area to the left of the row to select it.
Right-click anywhere in the selected row, and then click Delete Selected
Rows.

12. Click Yes when prompted to confirm deleting the row.
Note: The final result will display the new server name with the IP address
of the old server. The next time the service starts, the IP field will be
updated with the IP address of the new server.

13. Close Database Manager.
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Copying Custom Reports
Complete the following task to copy your custom reports to the new SolarWinds
SAM server.

To copy your reports:

1. On the old server, copy your custom reports located in the \Orion\Reports
folder.

2. Paste these reports into the Orion\Reports folder on the new server.

Updating Report Schemas
If you have added custom properties to the database, you will need to upgrade
the report schemas on the new server. Updating the report schemas allows
Report Writer to display and use custom property data.

To update report schemas for custom properties:

1. Ensure that Report Writer is closed, and then click Start > All Programs >
SolarWinds Orion > Grouping and Access Control > Custom Property
Editor.

2. Right-click on the toolbar, and then click Customize
3. Click the Commands tab, and then click Properties in the category list.
4. Drag Update Report Schemas to the toolbar to add a new button to the

toolbar.
5. Close the Customize window.
6. Click Update Report Schemas on the toolbar.
7. Click OK after the custom properties have been added to the report

schemas.
8. Close the Custom Property Editor.

Moving SolarWinds SAM Security Certificates to a New Server
SolarWinds SAM encrypts your sensitive data with a security certificate stored on
the original SolarWinds SAM server. To grant a new server access to this
encrypted data, you must copy the original security certificate to the new server.

Warning: If you do not replicate the original certificate, SolarWinds SAM on the
new server cannot access any credentials used by your component monitors, and
all of those component monitors will fail.

To replicate the original certificate:

1. Export the credential from the original server.
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a. On the StartMenu, click Run, type MMC, and then click OK.
b. On the File menu, click Add/Remove Snapin, and then click Add.
c. Select Certificates and then click Add.
d. Select Computer account and then click Next.
e. Select Local computer and then click Finish.
f. Click Close.
g. Click OK.
h. Expand the Certificates (Local Computer) > Personal > Certificates

group.
i. Right-click SolarWinds APM Engine (if present), and SolarWinds-
Orion, point to All Tasks on the shortcut menu, and then click Export.
Note: Exporting SolarWinds APM Engine is only required if you are
upgrading from APM 4.0.1 or earlier. If you have APM 4.0.2 or later, you
do not need to do anything with this certificate. Just migrate the
SolarWinds-Orion certificate.

j. Click Next in the Certificate Export Wizard.
k. Select Yes, export the private key, click Next, and then click Next

again.
l. Type and confirm a password for this private key, and then click Next.
m. Specify the file name to which you want to save the certificate, click

Next, and then click Finish—the certificate is saved with a .pfx file
name extension.

2. Copy the .pfx certificate file to the new server.
3. Import the certificate to the new server.

a. On the StartMenu, click Run, type MMC, and then click OK.
b. On the File menu, click Add/Remove Snapin, and then click Add.
c. Select Certificates, and then click Add.
d. Select Computer account, and then click Next.
e. Select Local computer, and then click Finish.
f. Click Close.
g. Click OK.
h. Expand the Certificates (Local Computer) group.
i. Expand the Personal group.
j. Expand the Certificates group.
k. If there is a SolarWinds SAM Engine item in the list, right-click

SolarWinds APM Engine and SolarWinds-Orion and select Delete
from the shortcut menu.

l. Right-click the Certificates—Personal—Certificates node, point to All
Tasks in the shortcut menu, and then click Import.

m. Click Next in the Certificate Import Wizard.
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n. Specify the .pfx certificate file you copied to the server and then click
Next.

o. Enter the password for the private key, check Mark this key as export-
able, and then click Next.

p. Select Place all certificates in the following store, and then select
Personal as the Certificate Store.

q. Click Next and then click Finish.

Migrating Licenses with License Manager
You must run License Manager on the computer where the currently licensed
SolarWinds products are installed before you can migrate licenses to a new
installation. The following procedure deactivates currently installed licenses that
can then be transferred to a new installation.

To deactivate currently installed licenses:

1. Click Start > All Programs > SolarWinds > SolarWinds License Man-
ager.

2. Check the products you want to deactivate on this computer.
3. Click Deactivate.
4. Specify your SolarWinds Customer ID and password when prompted, and

then click Deactivate.
Note: Deactivated licenses are now available to activate on a new com-
puter.

When you have successfully deactivated your products, log on to the computer on
which you want to install your products, and then begin installation. When asked
to specify your licenses, provide the appropriate information. The license you
deactivated earlier is then assigned to the new installation.

Installing License Manager
You will need to install License Manager on the computer from which you are
migrating currently licensed products.

Note: You must install License Manager on a computer with the correct time. If
the time on the computer is even slightly off, in either direction, from Greenwich
Mean Time (GMT), you cannot reset licenses without contacting SolarWinds
Customer Service. Time zone settings neither affect nor cause this issue.
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To install License Manager:

1. Click Start > All Programs > SolarWinds > SolarWinds License Manager
Setup.

2. Click I Accept to accept the SolarWinds EULA.
3. If you are prompted to install the SolarWinds License Manager application,

click Install.

Using License Manager

You must run License Manager on the computer where the currently licensed
SolarWinds product is installed before you can migrate licenses to a new
installation. The following procedure deactivates currently installed licenses that
can then be transferred to a new installation.

To deactivate currently installed licenses:

1. Click Start > All Programs > SolarWinds > SolarWinds License Man-
ager.

2. Check the products you want to deactivate on this computer.
3. Click Deactivate.
4. Specify your SolarWinds Customer ID and password when prompted, and

then click Deactivate.
Note: Deactivated licenses are now available to activate on a new com-
puter.

When you have successfully deactivated your products, log on to the computer on
which you want to install your products, and then begin installation. When asked
to specify your licenses, provide the appropriate information. The license you
deactivated earlier is then assigned to the new installation.

Upgrading SolarWinds APM when SolarWinds Failover Engine is
Installed
Prior to attempting this upgrade you should read the entire procedure.

On the primary/active server:

Note: If the secondary server is the active server, omit step 1 below.
1. Switch active server to secondary, shutdown Failover Engine on

primary server. Using the SolarWinds Orion Failover Manager, select the
secondary (passive) server and click Make Active. Wait for the secondary
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server to become active. After that stop Stop Orion Failover Engine from con-
text menu of tray icon.

2. Shutdown Orion Failover Engine on the secondary (active) server. Stop
Orion Failover Engine on the secondary (active) server leaving the pro-
tected applications running from context menu of tray icon.

On the secondary server:
1. Upgrade the desired SolarWinds product :

a. Install the SolarWinds Update by running the setup program.
b. If asked, reboot the server. After the reboot is complete, shutdown

the Failover Engine and proceed with the Configuration Wizard.
c. Verify that SolarWinds is operational.

2. If the upgrade procedure was successful, proceed to step 4.

3. If Upgrade on the secondary server fails:

a. Research the cause of the upgrade failure.
b. If the issue can be resolved, then it is safe to proceed with the

upgrade procedure. Otherwise, you can revert to a previous version.
c. To revert to a previous version:

i. Uninstall the upgraded components.
ii. On the secondary server, launch the SolarWinds Failover

Engine. Configure the Server wizard and click on the
Machine tab. Change the Current role to Sec-
ondary/passive.

iii. Reboot the server.
iv. SolarWinds Failover Engine will start and SolarWinds will be

stopped.
v. On the primary server, launch the SolarWinds Failover

Engine. Configure the Server wizard and click on the
Machine tab. Change the Current role to Primary/active.

vi. Restart SolarWinds Failover Engine on the primary server
and allow the system to synchronize.

vii. Start SolarWinds Failover Manager and check that the sys-
tem completes the full system check.

Needs to be updated:
l SQL is already updated, needs reverting.
l SolarWinds is not able to uninstall/upgrade, needs repair of the previous
release.
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4. Change the server role to Secondary/passive:

a. Start the Failover Engine in the context menu of the tray icon.
b. Stop the Failover Engine, including stopping all protected applic-

ations in the context menu of the tray icon.
c. Wait until all protected services are stopped.
d. Launch the Configure Server wizard and then click on the Machine

tab. Change the Current role to Secondary/passive.
e. Start the Failover Engine to enable the packet filter.
f. Shutdown Failover Engine.

On the primary Server (assuming a successful upgrade of secondary com-
pleted):

5. Perform upgrade on primary:

a. Disable Neverfail Packet Filter Driver on Public NIC
1. Open Properties of the Public Network Adapter.

l (e.g. in Network Connections window, accessible via
Control Panel, right click the Public Network Adapter
and select Properties)

2. Uncheck the Neverfail Packet Filter Driver item on the list
and close the window by clicking OK.

b. Install the SolarWinds Update by running the setup program.
c. If asked, reboot the server now. After the reboot is complete, shut-

down Failover Engine and proceed with the Configuration Wizard.
d. Verify that SolarWinds is operational.
e. Enable the Neverfail Packet Filter Driver on Public NIC

1. Open Properties of the Public Network Adapter.
l (e.g. in Network Connections window, accessible via
Control Panel, right click the Public Network Adapter
and select Properties)

2. Check the Neverfail Packet Filter Driver item on the list and
close the window by clicking OK.

6. Resume the Failover Engine:

a. Start the Failover Engine on the Primary Server.
b. Launch the Failover Manager on the Primary Server and make the

Primary Server Active using the Make Active… button.
c. Start Failover Engine on the Secondary server.
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d. Start Replication using the Start Replication… button in the Fail-
over Manager.

7. License SolarWinds

a. If applicable, license the application(s) on the Active (Primary)
server.

8. If SolarWinds fails to start on the secondary server, follow the steps below:

1. Shutdown the Failover Engine.
2. Launch the Configure Server wizard and set the secondary server role to

passive.
3. Start the Failover Engine on the secondary server.
4. Start the Configure Server wizard on the primary server and set the server

role to active.
5. Start the Failover Engine on the primary server.
6. Launch the SolarWinds Orion Failover Manager and verify that the system

completes the Full System Check.
7. Investigate the cause of the SolarWinds failure on the secondary server.

Installing SolarWinds Server & Application Mon-
itor
SolarWinds Server & Application Monitor offers an intuitive wizard to guide you
through installing and configuring the product. If you are performing a clean install
of SolarWinds SAM and also want to install SolarWinds NPM, you should install
SolarWinds NPM version 10.2.2 or higher. For more information, see “Installing
SolarWinds Network Performance Monitor” in the SolarWinds Network
Performance Monitor Administrator Guide.

To install or upgrade SolarWinds Server & Application Monitor:
1. Using an account with local administrative privileges, log on to the

SolarWinds server on which you want to install SolarWinds SAM. To
avoid permissions issues, this account should not be a domain
account, and it should not be subject to any local or group policy
restrictions.

2. If you downloaded the product from the SolarWinds website, complete
the following steps:
a. Navigate to the location of your downloaded .zip file, and then extract

the evaluation package to an appropriate location.
b. Launch the SolarWinds SAM evaluation executable.
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3. If you are prompted to install any required components, such as
Microsoft .NET Framework 3.5 or Microsoft ASP.NET 2.0 AJAX Exten-
sions, click Install and then complete the component installation.
Note: Downloading and installing Microsoft .NET Framework 3.5 may take
a long time, depending on your existing system configuration.

4. Review the Welcome text, and then click Next.

5. If the InstallShield Wizard detects that Microsoft Internet Information
Services (IIS) is not installed, suspend installation, quit setup, and then
install Internet Information Services (IIS).

6. If you had to install Internet Information Services (IIS), launch the
SolarWinds evaluation executable again.

7. Accept the terms of the license agreement, and then click Next.
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8. Accept the default install location, or navigate to a different location, and
then click Next.

9. Select either the Express Install – Recommended option or the
Advanced Install option, and then click Next.
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10. Click Next to start copying files. Installation begins.

11. After files are copied and installed, configuring begins automatically.
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12. Click Finish to exit the Configuration Wizard.

13. Type Admin in the User Name field, and then click LOGIN.
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14. The Network Sonar Wizard is displayed. Click Cancel and then confirm
that you want to cancel the network discovery by clicking OK.
Note: The wizard can be used to discover a set of nodes in your network.
You will use it later in this guide.

Uninstalling SAM
The following procedure fully uninstalls SAM and deletes the SAM database.

Notes:
l This is a general uninstall procedure, and it may differ slightly from version
to version.

l This is the recommended procedure when installing daily builds for testing.

To fully uninstall SAM and remove the SAM database:
1. Click Start > Control Panel > Add or Remove Programs.
2. Click SolarWinds Orion Server and Application Monitor..., and then click

Remove.
3. Complete the SAM uninstall wizard.
4. In the Add or Remove Programs window, click SolarWinds Job

Engine..., and then click Remove.
5. Complete the uninstallation of the SolarWinds Job Engine.
6. In the Add or Remove Programs window, click SolarWinds Orion Inform-

ation Service, and then click Remove.
7. Complete the uninstallation of the SolarWinds Orion Information Service.
8. Click Start > Run...
9. Type regedit, and then click OK.
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10. Expand HKEY_LOCAL_MACHINE > Software.
11. Delete both the SolarWinds and the SolarWinds.net folders.
12. If you are uninstalling Orion SAM from a 64-bit computer, expand HKEY_

LOCAL_MACHINE > Software > Wow6432Node, and then delete both the
SolarWinds and the SolarWinds.net folders.

13. Delete the SolarWinds folder from the Program Files folder on your main
volume. Typically, the Program Files folder is located at C:\Program
Files\.

14. Delete the SolarWinds folder from the Program Files\Common Files folder
on your main volume. Typically, the Common Files folder is located at
C:\Program Files\Common Files\.

15. Delete the SolarWinds website directory. Typically, the SolarWinds website
directory is located in C:\Inetpub\.

16. Delete the SolarWinds folder from the All Users\Application Data\ dir-
ectory. Typically, this SolarWinds folder is located in C:\Documents and Set-
tings\All Users\Application Data\.

17. Using your SQL Server tools, delete your Orion database. The Orion data-
base is typically named NetPerfMon, and it can be found in the Databases
folder of your SQL Server management application.

18. Using your SQL Server tools, delete your Orion database user. The Orion
database user can be found by expanding Security > Logins in your SQL
Server management application.

Advanced Installation of SAM
SolarWinds Server & Application Monitor offers an intuitive wizard to guide you
through installing and configuring the product.

To install or upgrade SolarWinds Server & Application Monitor:
l Using an account with local administrative privileges, log on to the
SolarWinds server on which you want to install SolarWinds SAM. To
avoid permissions issues, this account should not be a domain
account, and it should not be subject to any local or group policy
restrictions.

l If you downloaded the product from the SolarWinds website, complete
the following steps:

a. Navigate to the location of your downloaded .zip file, and then
extract the evaluation package to an appropriate location.

b. Launch the SolarWinds SAM evaluation executable.
l If you are prompted to install any required components, such as
Microsoft .NET Framework 3.5 or Microsoft ASP.NET 2.0 AJAX
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Extensions, click Install and then complete the component installation.
Note: Downloading and installing Microsoft .NET Framework 3.5 may take
a long time, depending on your existing system configuration.

l Review the Welcome text, and then click Next.

l If the InstallShield Wizard detects that Microsoft Internet Information
Services (IIS) is not installed, suspend installation, quit setup, and then
install Internet Information Services (IIS).

l If you had to install Internet Information Services (IIS), launch the
SolarWinds evaluation executable again.

1. Accept the terms of the license agreement, and then click Next.
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2. Accept the default install location, or navigate to a different location, and then
click Next.

3. Select the Advanced Install option, and then click Next.
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4. SAM will begin installation, taking you through multiple installation screens.
Click Next as prompted to be taken to the Database Settings of the Configuration
Wizard,

5. Configure the database for your environment by selecting the appropriate SQL
Server database and Authentication information, and then click Next.
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6. Select whether to Create a new database, or Use an existing database, and
then enter the information as needed, then click Next.

7. Select whether to Create a new account, or Use an existing account, and
then enter the account information, then click Next.
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l If the Website Settings page is displayed, configure the IP Address, Port,
and Website Root Directory as appropriate and select whether you want to
enable automatic login, then click Next.

8. Ensure that all the services displayed in the Service Settings page are
checked, and then click Next.
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9. Review the Configuration wizard Summary page, and then click Next.
10. Click Finish to complete the Configuration Wizard.

Note: If you encounter any issues with the additional polling engine, rerun the
Configuration Wizard on the SolarWinds SAM server.

To assign nodes to polling engines:

You can assign nodes to the polling engines by selecting the desired Polling
Engine in the Add Node wizard.
You can also perform Poller Load Balancing using the Monitor Polling Engines
tool to assign nodes to polling engines. Click Start > All Programs >
SolarWinds > Advanced Features > Monitor Polling Engines. Then click
Servers > Poller Load Balancing to display a dialog where you can assign
nodes to particular polling engines. For more information, see “Understanding
How Polling Engines Work" on page 930.

Activating Your License
After installing the software through the setup wizard, you are prompted to enter
the license activation key for your product. If you do not have an activation key,
the product runs in a time-limited evaluation mode.

To evaluate the software without a license:

1. Click Continue Evaluation.
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To license the software on a server with Internet access:

1. Click Enter Licensing Information.
2. Select I have internet access and an activation key.
3. Click the http://www.solarwinds.com/customerportal link to access the cus-

tomer portal on the SolarWinds web site.
4. Log on to the portal using your SolarWinds customer ID and password.
5. Click License Management on the left navigation bar.
6. Navigate to your product, choose an activation key from the Unregistered

Licenses section, and then copy the activation key.
7. If you cannot find an activation key in the Unregistered Licenses sec-

tion, contact SolarWinds customer support.
8. Return to the Activate SAM window, and then enter the activation key in

the Activation Key field.
9. If you access Internet web sites through a proxy server, click I access

the internet through a proxy server, and enter the proxy address and
port.

10. Click Next.
11. Enter your email address and other registration information, and then click

Next.

To license the software on a server without Internet access:

1. Click Enter Licensing Information
2. Select This server does not have internet access, and then click Next.
3. Click Copy Unique Machine ID.
4. Paste the copied data into a text editor document.
5. Transfer the document to a computer with Internet access.
6. On the computer with Internet access, complete the following steps:
7. Browse to http://www.sol-

arwinds.com/customerportal/licensemanagement.aspx and then log on to
the portal with your SolarWinds customer ID and password.

8. Navigate to your product, and then click Manually Register License.
9. If the Manually Register License option is not available for your product,

contact SolarWinds customer support.
10. Provide the Machine ID from Step 5, and then download your license key

file.
11. Transfer the license key file to the server.
12. Return to the Activate SAM window, browse to the license key file, and

then click Next.
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Finishing SolarWinds SAM Installation
After activating your license, you are prompted to configure SolarWinds SAM.
Doing so configures the SolarWinds database, web site, and services to work in
your specific environment.

Follow the directions in the SolarWinds Configuration Wizard:
Notes:

l Confirm that you have designated a SQL Server database instance for
SolarWinds SAM.

l Confirm that the Internet Information Services (IIS) Manager is not open
while the Configuration Wizard is running.

During configuration, the SolarWinds polling engine will shut down temporarily
with the result that, if you are actively polling, you may lose some polling data.
SolarWinds recommends that you perform upgrades during off-peak hours of
network usage to minimize the impact of this temporary polling stoppage.

To configure Server & Application Monitor:

1. If the Configuration Wizard has not loaded automatically, click Start >
All Programs > SolarWinds Orion > Configuration and Auto-
Discovery > Configuration Wizard.

2. Click Next on the Welcome window of the Configuration Wizard.
3. If you are prompted to stop services, click Yes.

Note: To ensure that all updates and changes are installed correctly, it is
imperative that you stop all services.

4. Specify the SQL Server instance you want to use to store network data.
5. Provide the credentials, if necessary, that are required to log into the selec-

ted instance.
Notes:

l If you are using an existing database, the user account needs only
to be in the db_owner database role for the existing database.

l If you are using an existing SQL account, the user account needs
only to be in the db_owner database role for the SolarWinds SAM data-
base.

The selected instance must support mixed mode or SQL authentication with
strong passwords. A strong password must meet at least three of the following
four criteria:

l Contains at least one uppercase letter.
l Contains at least one lowercase letter.
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l Contains at least one number.
l Contains at least one non-alphanumeric character, e.g., #, %, or ^.

For more information about authentication with strong passwords, see
http://msdn.microsoft.com/ms143705.aspx.

l If you are using SQL Express, specify your instance as (local) and use a
strong password. For more information about authentication with strong
passwords, see http://msdn.microsoft.com/ms143705.aspx. Due to its inher-
ent limitations, SolarWinds recommends against the use of SQL Express in
production environments.

l If you are creating a new database, the user account must be a member of
the dbcreator server role.  The sysadmin role and the sa user account are
always members of dbcreator.

l If you are creating a new SQL account for use with SolarWinds SAM, the
user account must be a member of the securityadmin server role.
Note: The sysadmin role and the sa user account are always members of
securityadmin.

6. Click Next.
7. If you are creating a new database, select Create a new database,

provide a name for the new database, and then click Next.
Note: SolarWinds recommends against using non-alphanumeric char-
acters in database names.

8. If you are using an existing database, select Use an existing database,
type the database name or select it from the list, and then click Next.

9. If you want to create a new SQL account for the SolarWinds SAM
polling engine and web console to use for accessing the database,
select Create a new account, provide an account name and password,
confirm the account password, and then click Next.

10. If you want to use an existing SQL account for the SolarWinds SAM
polling engine and web console to use for accessing the database,
select the existing account, provide the appropriate password, and then
click Next.

11. If you need to specify a particular IP Address for the SolarWinds SAM
Web Console, provide the IP address of the host web server.
Note: SolarWinds recommends the default All Unassigned unless your
environment requires a specific IP address for your SolarWinds Web Con-
sole.

12. Specify both the port through which you want to access the web console
and the volume and folder in which you want to install the web console
files.
Note: If you specify any port other than 80, you must include that port in the
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URL used to access the web console. For example, if you specify an IP
address of 192.168.0.3 and port 8080, the URL used to access the web con-
sole is http://192.168.0.3:8080.

13. Click Next.
14. If you are prompted to create a new directory, click Yes.
15. If you are prompted to create a new website, click Yes.

Note: Choosing to overwrite the existing website will not result in the dele-
tion of any custom SolarWinds SAM website settings you may have pre-
viously applied.

16. Confirm that all services you want to install are checked, and then click
Next.

17. Review the final configuration items, and then click Next.
18. Click Next on the Completing the SolarWinds Configuration Wizard dialog.
19. Click Finish when the SolarWinds Configuration Wizard completes.
20. Log in to the SolarWinds Web Console as an administrator.

Note: By default, you can log in with User Name Admin and no password.
21. If you have not discovered your network devices and added them to

the SolarWinds database, the Network Discovery Wizard starts.

Excluding SolarWinds Data Directories from Anti-
Virus Scanning
Anti-virus programs may lock files used by the SolarWinds Job Engine v2 during
scanning. This can cause the SolarWinds Job Engine v2 services to stop and
restart, causing delayed polling and gaps in data for a poll cycle.

SolarWinds recommends that you exclude certain SolarWinds data directories
(depending on your Windows platform) from your anti-virus scanning to improve
performance and stability:

Exclude for Windows Server 2003:

C:\Documents and Settings\All Users\Application
Data\SolarWinds

Exclude for Windows Server 2008:

C:\ProgramData\SolarWinds
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Running SolarWinds SAM
To run SolarWinds SAM:

1. Click Start > All Programs > SolarWinds Orion > Orion Web Console.
The SolarWinds Web Console is displayed. You can login by default by entering
the User name Admin and no password. Then click Login.

Internet Explorer Security Settings
If you are using Internet Explorer, SolarWinds recommends that you add the URL
of your SolarWinds website (http://FullSolarWindsServerName/), the URL of
SolarWinds support (http://support.solarwinds.com), and about:blank to the list of
trusted sites.

If you do not add these URLs to the list of trusted sites, you may see Internet
Explorer dialogs that contain messages similar to the following regarding
blocking website content:

l Content from the website listed below is being blocked by the Internet
Explorer Enhanced Security Configuration.

l To add the specified URLs to your trusted sites list, click the Add… button
in the Internet Explorer dialog.

For more information about adding sites to your trusted sites list, see the Microsoft
article, “Working with Internet Explorer Security Settings.”

Licensing
The SolarWinds SAM license you purchase is based on the number of allowed
assigned component monitors. A component monitor provides a statistic that you
want to monitor in SolarWinds SAM. You can have as many application templates
and assigned monitors as you need, as long as the number of assigned
component monitors does not exceed the license count.

If you have more assigned component monitors than allowed by your license, the
monitors that exceed your license limit are not activated, and their component
statuses are changed to "Not Licensed." You can either disable some assigned
component monitors to reduce your total assigned monitor count, or contact
SolarWinds about upgrading your SolarWinds SAM license.

AppInsight for SQL
When using AppInsight for SQL, 50 component monitors will count against your
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licensed number of component monitors, per SQL instance. For example, if you
have an active license for 1,500 component monitors and use AppInsight for
SQL to monitor ten instances of SQL, 500 component monitors will count against
your total license of 1,500, leaving you with 1,000 component monitors available
for use elsewhere. (50 X 10 = 500, 1,500 – 500 = 1,000). There is no restriction on
the number of databases you can have monitored. Also note that if you choose
not to use this application, you will not be penalized any number of component
monitors.

AppInsight for Exchange
When using AppInsight for Exchange, 50 component monitors will count against
your licensed number of component monitors, per Exchange Server. For
example, if you have an active license for 1,500 component monitors and use
AppInsight for Exchange to monitor 88 mailboxes over ten Exchange servers, 500
component monitors will count against your total license. The number of
mailboxes you have on these servers is irrelevant. (50 component monitors X 10
Exchange Servers = 500 component monitors used.) This will leave you with
1,000 component monitors available for use elsewhere. (1,500 component
monitors – 500 component monitors used for AppInsight for Exchange = 1,000
component monitors remaining). There is no restriction on the number of
mailboxes you can have monitored. Also note that if you choose not to use this
application, you will not be penalized any number of component monitors.

Asset inventory data collection does not count against your SAM component
monitor license.

Note: SolarWinds SAM licenses do not have to mirror the license count of any
other installed SolarWinds product. For example, you can install SolarWinds
SAM with a 150 component license on a SolarWinds NPM server with an
unlimited node license.

Windows Scheduled Task Monitor
The WSTM consumes five license units per node.
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To see the available component monitors remaining in your license:

1. Log on to the SolarWinds Web Console with an administrator account.
2. Click Applications.
3. Click SAM Settings.
4. Click SAM License Summary.

Note: As an alternative to the previous procedure, you can also click
License Details in the Settings page to view the used and available com-
ponent monitors.
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Chapter 3:
Common Tasks with SolarWinds
SAM
The features and flexibility provided by Server & Application Monitor give highly
detailed insight into the performance quality of applications on your network. The
tasks presented in this chapter illustrate the value of Server & Application Monitor,
and how it can immediately offer you a significant return on your investment:

l Monitoring Internal and External Web Site Performance
l Monitoring Microsoft Windows Performance
l Monitoring IIS Application Pools
l Scanning for Applications Worth Monitoring
l Monitoring VMware Performance Counters
l Monitoring and Restarting Stopped Windows Services
l Creating a Custom Component Availability Report
l Creating a Windows PowerShell Monitor
l Monitoring Large Directories

Monitoring Internal and External Web Site Per-
formance
You are the website administrator for your company. You are responsible for the
Intranet web site accessed by the employees and the corporate web site
accessed by the customers. You want to make sure both your employees and
customers are able to access your web sites and that you are alerted to any
problems that would prevent them from doing so.
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Deciding What to Monitor

The Intranet server is in your server room. To make sure only employees can
access the Intranet web site, the web site is secured using basic HTTP
authentication (htpasswd) that requires them to log on using a user name and
password. You decide to monitor this server using the HTTP template and the
valid credentials: user name "admin" and password "password.”

The corporate web server is hosted and managed by a web hosting company.
You can monitor the web site with the HTTP Template, but because you do not
have direct control over the server hardware, you will add the server to the
SolarWinds database as an external node.

Monitoring the Intranet Home Page

We need to add the Intranet web server to the SolarWinds database, and then
assign the SolarWinds SAM HTTP template to the web server.

1. Log on to the SolarWinds Web Console.
2. Click Applications if not already selected.
3. Add the Intranet web server to the SolarWinds database.

a. Click Add a Node.
b. Type the Hostname or IP Address of the Intranet web server.
c. Check the ICMP (Ping only) check box, select the appropriate

Polling Engine (if applicable), and then click Next.
d. In the Add Application Monitors page, click Next.

Note: If you wish to add an Application Monitor to the node, you
may do so either here or from the Application Settings as described
elsewhere in this guide.

e. In the Change Properties page, click OK, Add Node.
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Assign the HTTP template to the Intranet web server node.

a. Click Applications if not already selected.
b. Click SAM Settings.
c. Click Manually Assign Application Monitors.
d. SelectWeb Server in the Show only list.
e. Select HTTP, and then click Next.
f. Expand the categories and locate your Intranet web server node, select
it, and then click Next.

g. Select <New Credential> in the Choose Credential list.
h. Type Intranet Admin in the Credential Name field.
i. Type admin in the User Name field.
j. Type password in the Password and Confirm Password fields.
k. Click Test.
l. If the test fails, see “Troubleshooting the HTTP Template.”
m. Click Assign Application Monitors.
n. Click Done.

Monitoring the Corporate Home Page

We need to add the corporate web server to the SolarWinds database as an
external node, and then assign the HTTP template to the web server.

1. Log on to the SolarWinds Web Console.
2. Click Applications if not already selected.
3. Add the corporate web server to the SolarWinds database as an external

node.
a. Click Add a Node.
b. Type the Hostname or IP Address of the corporate web server.
c. Check the External check box, select the appropriate Polling Engine

(if applicable), and then click Next.
4. Assign the HTTP template to the corporate web server node.

a. SelectWeb Server in the Show only list.
b. Select HTTP.
c. Select Inherit credentials from template and then click Test.
d. If the test fails, see “Troubleshooting the HTTP Template.”
e. Click Next.
f. Enter the Name for your corporate web server.
g. Click OK, Add Node.
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Troubleshooting the HTTP Template

If the web site requires a user name and password, verify that you are entering a
working user name and password.

If the SolarWinds SAM server must connect to the Internet through a web proxy:

1. Click Assign Application Monitors even though the test failed.
2. Click Edit.
3. Click [+] to expand the HTTP Monitor component.
4. Click Override Template next to Use Proxy.
5. Check the Use Proxy check box.
6. Click Override Template next to Proxy Address.
7. Type the proxy address in the Proxy Address field using the syntax http://-

proxyaddress
8. Click Test All.
9. Click Submit.
10. Click Done.

Monitoring Microsoft Windows Performance
You are a systems administrator who maintains several Microsoft Windows
Server 2003 servers in your server room that host databases. Several database
users have complained recently that their databases are "running slow" during
certain times of the day. You want to monitor the performance of these database
servers to see what you can do to remedy the situation.

Deciding What to Monitor

You suspect that the disk systems on a few of these servers need to be upgraded
to RAID or something similar to increase the speed. You know that monitoring the
disk queue length for each system would tell you whether there is an I/O
bottleneck.
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You decide to apply the Windows Server 2003-2008 template to these servers
because it includes a built-in Disk Queue Length monitor.

Monitoring the Windows 2003 Servers

We need to add the server nodes to the SolarWinds database, assign the
Windows Server 2003-2008 template to the server nodes, and then adjust the
warning threshold of the template's Disk Queue Length component to >2. This will
make SolarWinds SAM send us a warning if the Disk Queue Length of any server
is greater than 2.

The Windows 2003 servers occupy the IP address range 192.168.1.120 to
192.168.1.127. We could add each server to the SolarWinds database one at a
time, but it is easier to add the entire IP range using SolarWinds Network
Discovery.

1. Log on to the SolarWinds Web Console.
2. Add the Windows 2003 servers to the SolarWinds database.

a. Click Settings.
b. Click Network Sonar Discovery.
c. Click Add New Discovery.
d. Click Next.
e. Click Next.
f. Enter 192.168.1.120 as the Start address, 192.168.1.127 as the End
address, and then click Next.

g. Click Next to save the discovery settings.
h. Click Discover to begin the discovery process. The Discovering Net-

work dialog is displayed.
i. Click Next on each page until you reach the Import Preview page.
j. When you reach the Import Preview page, click Import.
k. When you reach the Results page, click Finish.

3. Assign the Windows 2003-2008 template to your Windows 2003 server
nodes.
a. Click Applications if not already selected.
b. Click SAM Settings.
c. Click Manually Assign Application Monitors.
d. SelectWindows in the Show only list.
e. SelectWindows Server 2003-2008, and then click Next.
f. Browse to your Windows 2003 nodes, select all of them, and then click
Next.

g. Enter sysadmin in the Credential Name field.
h. Enter your administrator user name in the User Name field.
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i. Enter your password in the Password and Confirm Password fields.
j. Click Test.
k. If the test fails, see “Troubleshooting the Windows 2003-2008 Tem-

plate.”
l. Click Assign Application Monitors, and then click Done.

4. Change the Disk Queue Length warning threshold of the Windows 2003-
2008 template to >2.
a. Click SAM Settings.
b. Click Manage Templates.
c. SelectWindows in the tag group column.
d. Check theWindows Server 2003-2008 check box.
e. Click Edit.
f. Click [+] to expand the Disk Queue Length group.
g. Enter greater than 2 for the Statistic Warning Threshold, and then click

Submit.

Troubleshooting the Windows 2003-2008 Template.

Verify that you are entering the user name and password of an administrator-level
account. If you think you have entered an incorrect credential, correct the mistake
and then retest.

Note:Windows Performance Counters use RPC for communication which runs
over TCP port 445.

Verify that the monitored server allows remote WMI connections. Consult the WMI
Troubleshooting Guide if you are unsure whether the monitored server allows
remote WMI connections. The guide is available from:

http://www.solarwinds.com/support/apm/docs/APMWMITroubleshooting.pdf

For information about troubleshooting the Windows performance counters, refer to
the KB article “How can I troubleshoot SolarWinds SAM performance monitoring
and Windows performance counters?”:

http://knowledgebase.solarwinds.com/kb/questions/2139

Monitoring IIS Application Pools
You maintain a web server that hosts five different web sites through Internet
Information Services (IIS) 6.0 using application pools to separate each web site.
Everything was fine at first, but the average load time for the web pages has
doubled as business has grown, and you suspect it may be time to move at least
one of the web sites to a new server.
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Deciding What to Monitor

Internet Information Services 6.0 runs each application pool in a new instance of
wp3w.exe. Monitoring the five w3wp.exe instances individually will let you see
which web site is using the most system resources. You can then make a more
informed decision as to which web site you should move to the new server.

Note: w3wp.exe is running only if there are HTTP requests made to a server. To
keep w3wp.exe running if no HTTP requests are made to that server, add an
HTTP Monitor to the same application. The HTTP Monitor will then check the
same website and generate HTTP requests, thereby keeping w3wp.exe running.

What needs to be monitored:

Five instances of w3wp.exe, differentiated by application pool. SolarWinds SAM
can monitor them separately if you specify the application pool names in the
component monitors.

1. Log on to the SolarWinds Web Console.
2. Click Applications if not already selected.
3. Add the web server to the SolarWinds database.

a. Click Add a Node.
b. Type the hostname or IP address of the Intranet web server.
c. Check the ICMP (Ping only) check box and then click Next.
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d. In the Add Application Monitors page, click Next.
e. In the Change Properties page, Click OK, Add Node.

4. Find the wp3w.exe process on the web server.
a. Click Applications if not already selected.
b. Click SAM Settings.
c. Click Component Monitor Wizard.
d. Select Process Monitor – WMI as the monitor type, and then click

Next.
e. Click Browse, select the web server, and then click Select.
f. Enter WebServerAdmin in the Credential Name field.
g. Enter your administrator user name in the User Name field.
h. Enter your password in the Password and Confirm Password fields.
i. Click Next.
j. Wait for the process list to load.
k. Click the last page button to view the last page.
l. Check the check box next to w3wp.exe, and then click Next.
m. Change Monitor Name to Webpool1.
n. Enter webpool1 in the Command Line Filter field.
o. Change the CPU Warning Threshold to greater than 40.
p. Change the CPU Critical Threshold to greater than 50.
q. Click Add Another Component.
r. Repeat steps d through q, changing the Monitor Name and Command

Line Filter fields appropriately for the four remaining webpool filters.
s. After creating the monitors for all five w3wp.exe instances, click Next.
t. Select New Application Monitor.
u. Type Web Server Application Pools as the Application Monitor Name, and

then click Next.
v. Select the web server node, and then click Next.
w. Review the list of component monitors to create, and then click OK,

Create.

Scanning for Applications Worth Monitoring
You already use SolarWinds SAM for monitoring applications critical to your own
job functions. Now, you want to discover and monitor other applications that are
hosted in your organization's network.
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What needs to be monitored:

You decide to scan for Windows and IIS because you have the Windows
administrator password to access many computers on the network and you have
a hunch at least a few of them are running IIS.

All the computers in your network are already in the SolarWinds database, so
there is no need to add them.

The administrator user name and passwords are:

User Name: WAREHOUSE\Administrator
Password: H0merSamps0n
User Name: IT\Administrator
Password: FourLights

1. Log on to the SolarWinds Web Console.
2. Click Applications if not already selected.
3. Click SAM Settings.
4. Click Scan Nodes for Applications.
5. Select nodes:

a. Click [+] to expand the node groups.
b. Select the nodes you want to scan, and then click Next.

6. Select applications to find.
a. Uncheck all applications except:

l Internet Information Services
l Windows Server 2003-2008.

b. Click Next.
7. Enter the credentials for the servers you are scanning:

a. Click Add Credential.
b. Type Warehouse Admin in the Credential Name field.
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c. Type WAREHOUSE\Administrator in the User Name field.
d. Type H0merSamps0n in both the Password and Confirm Password

fields.
e. Click Submit.
f. Click Add Credential.
g. Type IT Admin in the Credential Name field.
h. Type IT\Administrator in the User Name field.
i. Type FourLights in the both the Password and Confirm Password
fields.

j. Click Submit.
k. Click Next.

8. Click Start Scan.
9. Click View SAM Summary Page.
10. Click View results (near the top of the page) after the SAM scan is com-

plete.
11. Review the results of the scan.

Monitoring a Specific URL
To monitor a specific URL, follow the step outlined below:

1. Login to the Web Console and navigate to Settings.
2. Click Manage Nodes and then click Add Node.
3. Enter the URL you want to monitor (eg: www.google.com) and select “No

Status: External Node,” as highlighted below:
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4. Click Next and then selectWeb Pages from the drop-down menu.

5. CheckWeb Link and select Inherit credentials from Template. Click
Test and then click Next.

6. On the Change Properties page, review properties you wish to change and
then click,OK, Add Node.
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7. Navigate to the Node Details page to review the results. To do this, click
the Home tab then drill down to your specific node in the All Nodes
resource.

Monitoring VMware Performance Counters
You want to ensure the health of your VMware environment.

What needs to be monitored:

You want to create an Application Monitor that uses VMware performance
counters provided by the VMware wizard to monitor the health of various aspects
of your VMware environment.

To create a new Application Monitor using the browsing method to select
the desired VMware performance counters:

1. Log on to your SolarWinds Web Console with an Administrator account.
2. Click the Applications tab.
3. Click SAM Settings.
4. Click Component Monitor Wizard underneath Getting Started with SAM.
5. Select one of the following component monitor types, depending on

whether you want to browse for ESX or vCenter performance counters:
VMware ESX Performance Counter MonitorVMware vCenter Per-
formance Counter Monitor

6. Click Next.
7. Type the IP address of the VMware node you want to browse, or click

Browse, select the node from the list, and click SELECT.
8. If suitable credentials already exist, choose the credential from the

Choose Credential list.
9. If suitable credentials do not exist, choose <New Credential> from the

Choose Credential list, and then add the new credential by filling out the
credential details.

10. Click Next.
11. Select whether you want to monitor A single system orMultiple systems.
12. Choosing A single system will provide specific counters that apply to the

target system only.
Note: This option provides all available performance counters with
instances for the specified Entity Type. Since the performance counters
selected may contain instances, the Application Monitor or template cre-
ated based on them cannot be considered as generic, and may only be
assigned to the specific target node you specified in step 7 above.
Choosing Multiple systems will provide more generic counters that can
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be applied to multiple systems.
Note: This option provides only aggregate performance counters (without
instances). Therefore the Application Monitor or template created based on
them can be considered as generic and assigned to different ESX/vCenter
target hosts. In this case, monitors in the application or template created
will contain the special ${VMWARE_ENTITY_NAME} variable in the Entity
Name field of the monitor. When the monitor runs, this variable will be
resolved to the first available Entity on a target host with the desired Entity
Type (for example, the first Host System).

13. Select the desired VMware Entity Type to monitor:
l Cluster Compute Resource (only available if the VMware vCenter Per-
formance Counter Monitor type is selected in step 5) – Data object that
aggregates the computation resources of its associated Host System
objects into one single computation resource for use by virtual machines.
The cluster services such as HA (High Availability), DRS (Distributed
Resource Scheduling), and EVC (Enhanced vMotion Compatibility),
enhance the usefulness of this single computation resource. This Entity
Type is specific to vCenter systems.

l Host System – Managed object type that provides access to a virtualization
host platform.

l Resource Pool – Represents a set of physical resources which may be a
single host, a subset of a host's resources, or resources spanning multiple
hosts. You can subdivide Resource pools by creating child resource pools.
In order to run, a virtual machine must be associated as a child of a resource
pool. In a parent/child hierarchy of resource pools and virtual machines, the
root resource pool is the single resource pool that has no parent pool.

l Virtual Machine – Managed object type for manipulating virtual machines,
including templates that can be repeatedly deployed as new virtual
machines. This object type provides methods for configuring and controlling
a virtual machine.

14. If you selected the A single system option in step 11, select the desired
VMware Entity to monitor.

15. Select the desired Performance Object (group) to monitor. For example, if
you want to monitor CPU counters, select CPU.

16. Select the check boxes next to the counters to monitor for the selected Per-
formance Object.
Note: To select all the counters listed, select the check box next to
Counter.
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The selected counters are listed in the Selected items list with a red X
next to each one. To delete an item, click the red X next to the item and it
will be removed from the list.

17. If you want to select counters from an additional Performance Object,
select the next Performance object and then add the desired counters for it.

18. When you are finished selecting counters, click Next.
19. If you selected the A single system option in step 12, select the desired

counter instances to monitor:
a. Use the Group By dropdown to display the counters for a particular Per-

formance Object, or select All Counters.
b. Click the name of the desired counter to choose its instances.
c. Select the check box(es) next to the desired instance(s) to monitor.

Note: To select all the instances listed, select the check box next to
Instance Name.
The selected instances are then displayed in the Selected items list
with a red X next to each one. To delete an item, click the red X next to
the item and it will be removed from the list.

d. When you are finished selecting counter instances, click Next.
20. The Edit Properties page is displayed with the component monitors that

have been created for each of your selected counters or coun-
ters/instances.
Here you can modify settings such as the Monitor Name, which defaults to
the counter name that was selected. This is only a descriptive label, and
can be modified as desired.

If you chose the Multiple systems option in step 11, you can see the
special ${VMWARE_ENTITY_NAME} variable in the Entity Name field of the
monitor. When the monitor runs, this variable will be resolved to the first
available Entity on a target host with the desired Entity Type (for example,
the first Host System).
You also need to configure your warning and critical thresholds for
response time and statistic.

21. When you are finished editing monitor properties, click Next.
22. The Add to Application Monitor or Template page is displayed with the

Component list collapsed. Click [+] next to Component list to expand the
list of counters or counters/instances to be added.

23. Select New Application Monitor. Then enter a name for the new Applic-
ation Monitor, for example: VMware Disk and CPU Monitor.
You can change the name of the Application Monitor up to and including
step 26.
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24. If you selected the Multiple systems option in step 11, expand the list of
nodes and select the nodes to monitor. Only VMware ESX and vCenter
nodes are displayed.

25. Click Next.
26. Click OK, Create.
27. Click View SAM Summary Page.
28. Your new VMware monitor appears in the tree view for the All Applications

resource. The polling results for the new monitor are updated after a few
minutes.

Monitoring and Restarting Stopped Windows Ser-
vices
You want to ensure the health of your Windows server by monitoring the services
that are running. If any services are stopped, they should be restarted.

What needs to be monitored:

You want to create an Application Monitor that monitors Windows services. You
also want to create an alert that attempts to restart any services that are stopped
and sends an email.

To create a new Application Monitor template using the browsing method to
select the desired Windows services and then assign it to the desired
nodes:

1. Log on to your SolarWinds Web Console with an Administrator account.
2. Click the Applications tab.
3. Click SAM Settings.
4. Click Component Monitor Wizard underneath Getting Started with SAM.
5. Select the following component monitor type:

Windows Service Monitor
6. Click Next.
7. Type the IP address of the Windows node you want to browse, or click

Browse, select the node from the list, and click SELECT.
8. If suitable credentials already exist, choose the credential from the

Choose Credential list.
9. If suitable credentials do not exist, choose <New Credential> from the

Choose Credential list, and then add the new credential by filling out the
credential details.

10. Click Next.
11. Browse the list of services and check the boxes for the services to monitor.
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12. Adjust thresholds as desired.
13. Click Next.
14. Ensure that New Application Monitor Template Name is selected and

then enter a name for your new template, for example Cus-
tomWindowsServices.

15. Click Next.
16. Select the boxes for the desired nodes to monitor and click Next.
17. Click OK, Create to create the assigned Application Monitor.

To create an alert that restarts any stopped Windows services and sends an
email:

1. Click Start > All Programs > SolarWinds Orion > Alerting, Reporting,
and Mapping > Advanced Alert Manager.

2. Click Configure Alerts.
3. Scroll to the bottom of the list in the Manage Alerts dialog, and check the

box for Restart a service.
4. If you would also like to send an e-mail notification for the service

restart:
a. Highlight Restart a service and click Edit.
b. Select the Trigger Actions tab and then click Add New Action.
c. Select Send an E-Mail / Page and click OK.
d. Complete the e-mail info and click OK.
e. Click OK.

5. Click Done.
For more information about restarting Windows services with an alert action, see
“Restarting Windows Services with an Alert Action” on page 737.

Creating a Custom Component Availability Report
The following procedure generates an example report of component average
availability information over the previous week. The final report is sorted so that
the worst items are viewed last. Components are listed in order of decreasing
availability.

Open Report Writer by clicking Start > All Programs > SolarWinds Orion >
Alerting, Reporting, and Mapping > Report Writer.
Note: At any point during the creation of a report (or perhaps at many points), you
may save what you have done by clicking File > Save. The first time you save
you must give your report a filename or accept the default, which will be the report
title that you assign in the following procedure.
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To generate an example report of component availability information:

1. Click File > New Report.
2. The example calls for a report on component availability over the past

week, so select APM: Historical – Daily Component Availability, and
then click OK.

3. Type My Reports in the Report Group field.
4. Enter Last Week’s Component Availability as the Report Title.
5. Select Portrait for the paper orientation.
6. Click the Select Fields tab.
7. Click Browse (...), and then select Add a new field.
8. Click the Field asterisk, and then select Date/Time (Daily Component

Availability Filtering Only) > DateTime.
9. Click Browse (...), and then select Add a new field.
10. Click the Field asterisk, and then select Network Nodes > Node

Details >Node Name.
11. Click Browse (...), and then select Add a new field.
12. Click the Field asterisk, and then select Historical Daily Component

Availability > Application > Application Name.
13. Click Browse (...), and then select Add a new field.
14. Click the Field asterisk, and then select Historical Daily Component

Availability > Component > Component Name.
15. Click Browse (...), and then select Add a new field.
16. Click the Field asterisk, and then select Historical Daily Component

Availability > Component > ComponentAvailability.
17. On the line for Component Availability, click the function asterisk and

then select Average.
18. Click Preview to run the SQL query and view the report data in the Pre-

view window.
19. Click Design in the toolbar to return to design mode.
20. Click the Field Formatting tab.
21. Select DateTime from the field list.
22. Change the Column Header entry to Date/Time.
23. Select Application_Name from the field list.
24. Change the Column Header entry to Application Name.
25. Select Component_Name from the field list.
26. Change the Column Header entry to Component Name.
27. Select Average_of_ComponentAvailability from the field list.
28. Change the Column Header entry to Average Component Availability.

Note: Column widths are adjustable. To change a column width, place
your cursor on the column divider and drag it to a different position.
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29. Click Preview to run the SQL query and view the report data in the Pre-
view window.

30. Click Design in the toolbar to return to design mode.
31. Click the Select Fields tab.
32. Click the sort asterisk on the Component Availability field line, and then

select descending.
33. Click Preview to run the SQL query and view the report data in the Pre-

view window.
34. Click Design in the toolbar to return to design mode.
35. Click the Time Frame tab.
36. Select Relative Time Frame, type 7 in the text field, and then select Days

from the list.
37. If you want to break down the report day-by-day, click the Sum-

marization tab and specify your choices.
38. If you want to filter your report, click the Filter Results tab and specify fil-

ter rules.
39. Click File > Save to save your work.

Monitoring Large Directories
You already use the Directory Size monitor in SolarWinds SAM for monitoring
small and medium-sized directories. Now you need to monitor a very large
directory.

You discover the Directory Size monitor has problems monitoring the very large
directory, which contains hundreds or even thousands of files, because the
monitor timeout may lapse before the target computer can finish computing the file
sizes and sending the response.

In order to work around this issue, you decide to use the Windows Script monitor
instead to execute a Visual Basic script that uses the Scripting.FileSystemObject
to calculate the directory size.

What needs to be monitored:

You decide to monitor the very large directory using the Windows Script monitor,
because this method should be as fast as if you view the folder properties in
Windows Explorer to get the size and avoid the timeout issues.

1. Log on to your SolarWinds Web Console with an Administrator account.
2. Click the Applications tab.
3. Click SAM Settings.
4. Click Create a New Template underneath Application Monitor Templates.
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5. Type a name for your template in the Template Name field, for example
Large Directory Monitor.

6. If you want to turn on extended debug information to assist Customer
Support, expand Advanced and then set Debug logging On and specify
the Number of log files to keep.
Here you can also select either 32bit or 64bit from the dropdown list
entitled, Platform to run polling job on.
Note: Do not turn on Debug logging unless directed by Customer Sup-
port.

7. Click Add Component Monitor.
8. Expand the Custom Component Monitors group, and then checkWin-

dows Script Monitor.
9. Click Submit.
10. Select credentials with appropriate permissions to run the script on the

SolarWinds SAM server, and that also has appropriate permissions to do
whatever else the script requires.

11. Copy the following Visual Basic script to get the directory size into the
Script Body field:

Dim folderPathfolderPath = WScript.Arguments(0)Set fs =
WScript.CreateObject ("Scripting.FileSystemObject")Set folder
= fs.GetFolder(folderPath)WScript.Echo "Message: Folder " &
folderPath & " is " & folder.Size & " bytes large"

WScript.Echo "Statistic: " & folder.Size

The VB code does the following:
a. Reads the first argument passed to the script (the UNC pathname for

the directory to monitor) and stores it in folderPath.
b. Creates the Scripting.FileSystemObject and stores it in fs.
c. Gets the folder name from the saved command line argument and

stores it in folder.
d. Displays the message with the folder name and the folder size.
e. Displays the statistic (folder size in bytes).

Note: The script does no error checking, such as handling the case if
the folder does not exist.

12. Type the UNC pathname for the directory name to monitor into the Script
Arguments field.

You can use the token ${IP} and the IP address will be filled in with the IP
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address of the target node to which the monitor is assigned when the Windows
Script monitor runs.

For example, if you type the following UNC pathname for the directory name in
the Script Arguments:
\\${IP}\c$\my_large_directory

the VBscript will get the size of the directory c:\my_large_directory on the node to
which the Windows Script monitor is assigned.

13. Specify the critical and warning thresholds appropriately based on the
desired directory size.

14. Click Submit.
15. Create an assigned Application Monitor by assigning the Large Directory

Monitor template to the desired node to monitor.
a. Click the Applications tab.
b. Click SAM Settings.
c. Click Manually Assign Application Monitors underneath Getting Star-

ted with SAM.
d. Select All in the Show only list.
e. Click Large Directory Monitor and then Next.
f. Click Manually Assign Application Monitors underneath Getting Star-
ted with SAM.

g. Select All in the Show only list.
h. Click Large Directory Monitor and then click Next.
i. Browse to the desired node to monitor, select it, and then click Next.
j. Enter itadmin in the Credential Name field.
k. Enter your administrator user name in the User Name field.
l. Enter your password in the Password and Confirm Password fields.
m. Click Test.
n. If the test fails, see “Troubleshooting the Windows 2003-2008 Tem-

plate..”
o. Click Assign Application Monitors, and then click Done.

Troubleshooting the Large Directory Monitor

Verify that you are entering the user name and password of an administrator-level
account. If you think you have entered an incorrect credential, correct the mistake
and then retest.

If you made a mistake with the spelling of the directory name, correct it and then
retest.
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Chapter 7:
Discovering and Adding Nodes on a
Network
There are two methods to add nodes in SolarWinds SAM:

l Add a Single Node*
* For more information, see “Adding Nodes for Monitoring” on page 188.

l Network Sonar Discovery

This chapter describes the process of discovering network devices and then
adding them to the SolarWinds database via Network Sonar Discovery.

The method recommended largely depends on the number of nodes to be added.
To discover and add a larger number of nodes across your enterprise, the
Network Sonar Discovery and Network Sonar Results wizards are available,
respectively. This chapter provides instructions for quickly populating your
SolarWinds SAM database with the nodes you want to monitor and manage with
SAM. The Web Console also provides an easy to use Web Node Management
wizard suited to discovering and adding individual nodes.

Refer to the following sections for more information:

l Discovery Central
l Network Sonar Discovery
l Using the Network Sonar Results Wizard
l Managing Scheduled Discovery Results
l Using the Discovery Ignore List

Discovery Central
Discovery Central provides a centralized overview of the types and number of
nodes you are monitoring. You can also access Network Discovery and
Virtualization Discovery from within Discovery Central.
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To access Discovery Central:

1. Click Settings at the top right of the SolarWinds Web Console.
2. Click Discovery Central in the Getting Started with SolarWinds category.

Note: Clicking Go to SolarWinds Home opens the SolarWinds Summary
Home view for your entire monitored network.

Refer to the following sections for more information:

l Virtualization Discovery
l Application Discovery

Virtualization Discovery
The Virtualization Discovery category displays information for both VMware and
Hyper-V infrastructures on your network. To use virtualization discovery, click
Network Sonar Discovery to discover multiple nodes or click Add A Single
Device to add a single node. For more information, see “Polling for VMware
nodes Using the Network Sonar Wizard” on page 328.

Application Discovery
SolarWinds SAM can scan nodes and automatically assign the Application
Monitors it deems suitable for each scanned node. You control the nodes to be
scanned, the application templates used in the scan, and the scanning
parameters that determine a match. For more information, see "Application
Discovery" on page 278.

Network Sonar Discovery
SolarWinds SAM employs the easy to use Network Sonar Wizard in order to aid
in the discovery of nodes on your network. Before using the Network Sonar
Wizard, consider the following points about network discovery in SAM:

l The Network Sonar Wizard recognizes network devices that are already in
your SolarWinds database and prevents you from importing duplicate
devices.

l CPU and Memory Utilization charts are automatically enabled for your Win-
dows, Cisco Systems, VMware, and Foundry Networks devices.

l The community strings you provide in the Network Sonar Wizard are only
used for SNMP GET requests, so read-only strings are sufficient.
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The following procedure steps you through the discovery of devices on your
network using the Network Sonar Wizard, automatically followed by the Network
Sonar Results Wizard:

To discover devices on your network from Discovery Central:

1. If the Network Sonar Wizard is not already open, click Start > All
Programs > SolarWinds > Configuration and Auto-Discovery >
Network Discovery.

2. Click Network Sonar Discovery.

3. If you want to create a new discovery, click Add New Discovery.
4. If you have already defined a network discovery, a number of options

are available on the Network Sonar Discovery tab. Select one of the fol-
lowing:

l If you want to edit an existing discovery before using it, select
the discovery you want to edit, and then click Edit.

l If you want to use an existing discovery to rediscover your net-
work, select the discovery you want to use, click Discover Now,
and then complete the Network Sonar Results Wizard after dis-
covery completes. For more information about network discovery
results, see “Using the Network Sonar Results Wizard” on
page 274.

l If you want to import some or all devices found in a defined dis-
covery that you may not have already imported for monitoring,
select a currently defined discovery, and then click Import All Res-
ults. For more information about network discovery results, see
“Using the Network Sonar Results Wizard” on page 274.

l If you want to import any newly enabled devices matching a
defined discovery profile, select a currently defined discovery, and
then click Import New Results. For more information about network
discovery results, see “Using the Network Sonar Results Wizard” on
page 274.

l If you want to delete an existing discovery profile, select a cur-
rently defined discovery and then click Delete.

5. If the devices on your network do not require community strings
other than the default strings public and private provided, click Next on
the SNMP Credentials view.
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6. If any of your network devices require community strings other than
public and private or if you want to use an SNMPv3 credential, complete
the following steps to add the required SNMP credential.
Note: Repeat the following procedure for each new community string. To
speed up discovery, highlight the most commonly used community strings
on your network, and then use the arrows to move them to the top of the
list.
a. Click Add New Credential, and then select the SNMP Version of your

new credential.
b. If you are adding an SNMPv1 or SNMPv2c credential, provide the

new SNMP Community String.
c. If you are adding an SNMPv3 credential, provide the following inform-

ation for the new credential:
l User Name, Context, and Authentication Method
l Authentication Password/Key, Privacy/Encryption Method
and Password/Key, if required.

d. Click Add.
7. Click Next on the SNMP Credentials view.

8. If you want to discover any VMware VCenter or ESX Servers on your
network, confirm that Poll for VMware is checked, and then complete the
following steps to add or edit required VMware credentials.
Note: Repeat the following procedure for each new credential. To speed
up discovery, use the up arrow to move the most commonly used cre-
dentials on your network to the top of the list.
a. Click Add vCenter or ESX Credential.
b. If you are using an existing VMware credential, select the appro-

priate credential from the Choose Credential dropdown menu.
c. If you are adding a new VMware credential, select <New Cre-

dential> in the Choose Credential dropdown menu, and then provide
a new credential name in the Credential Name field.
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Note: SolarWinds recommends against using non-alphanumeric char-
acters in VMware credential names.

d. Add or edit the credential User Name and Password, as necessary.
e. Confirm the password, and then click Add.

9. Click Next on the Local vCenter or ESX Credentials for VMware view.

10. If you want to discover devices located on your network within a spe-
cific range of IP addresses, complete the following procedure.

Note:Only one selection method may be used per defined discovery.

a. Click IP Ranges in the Selection Method menu, and then, for each IP
range, provide both a Start address and an End address.
Note: Scheduled discovery profiles should not use IP address ranges
that include nodes with dynamically assigned IP addresses (DHCP).

b. If you want to add another range, click Add More, and then repeat
the previous step.
Note: If you have multiple ranges, click X to delete an incorrect range.

c. If you have added all the IP ranges you want to poll, click Next.

11. If you want to discover devices connected to a specific router or on a
specific subnet of your network, complete the following procedure:
Note:Only one selection method may be used per defined discovery.
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a. Click Subnets in the Selection Method menu.
b. If you want to discover on a specific subnet, click Add a New Sub-

net, provide both a Subnet Address and a Subnet Mask for the
desired subnet, and then click Add.
Note: Repeat this step for each additional subnet you want to poll.

c. If you want to discover devices using a seed router, click Add a
Seed Router, provide the IP address of the Router, and then click
Add.
Notes:

l Repeat this step for each additional seed router you want to use.
l Network Sonar reads the routing table of the designated router
and offers to discover nodes on the Class A network (255.0.0.0
mask) containing the seed router and, if you are discovering
devices for a SolarWinds SAM installation, the Class C networks
(255.255.255.0 mask) containing all interfaces on the seed router,
using the SNMP version chosen previously on the SNMP Cre-
dentials page.

l Networks connected through the seed router are NOT auto-
matically selected for discovery.

d. Confirm that all networks on which you want to conduct your network
discovery are checked, and then click Next.

12. If you already know the IP addresses or hostnames of the devices
you want to discover and include in the SolarWinds database, com-
plete the following procedure:
a. Click Specific Nodes in the Selection Method menu.
b. Type the IPv4 or IPv6 addresses or hostnames of the devices you want

to discover for monitoring into the provided field.
Note: Type only one address or hostname per line.

c. Click Validate to confirm that the provided addresses and hostnames
are assigned to SNMP-enabled devices.

d. If you have provided all the addresses and hostnames you want to
discover, click Next.

13. Configure the options on the Discovery Settings view, as detailed in the fol-
lowing steps:
a. Provide a Name and Description to distinguish the current discovery

profile from other profiles you may use to discover other network areas.
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Note: This Description displays next to the Name in the list
of available network discovery configurations on the
Network Sonar view.

b. Position the slider or type a value, in ms, to set the SNMP Timeout.
Note: If you are encountering numerous SNMP timeouts during Net-
work Discovery, increase the value for this setting. The SNMP Timeout
should be at least a little more than double the time it takes a packet to
travel the longest route between devices on your network.

c. Position the slider or type a value, in ms, to set the Search Timeout.
Note: The Search Timeout is the amount of time Network Sonar Dis-
covery waits to determine if a given IP address has a network device
assigned to it.

d. Position the slider or type a value to set the number of SNMP Retries.
Note: This value is the number of times Network Sonar Discovery will
retry a failed SNMP request, defined as any SNMP request that does
not receive a response within the SNMP Timeout defined above.

e. Position the slider or type a value to set the Hop Count.
Note: If the Hop Count is greater than zero, Network Sonar Discovery
searches for devices connected to any discovered device. Each con-
nection to a discovered device counts as a hop.

f. Position the slider or type a value to set the Discovery Timeout.
Note: The Discovery Timeout is the amount of time, in minutes, Net-
work Sonar Discovery is allowed to complete a network discovery. If a
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discovery takes longer than the Discovery Timeout value provided, the
discovery is terminated.

14. If you only want to use SNMP to discover devices on your network,
check Use SNMP only.
Note: By default, Network Sonar uses ICMP ping requests to locate
devices. Most information about monitored network objects is obtained
using SNMP queries.

15. If multiple SolarWinds polling engines are available in your envir-
onment, select the Polling Engine you want to use for this discovery.

16. Click Next.
17. If you want the discovery you are currently defining to run on a reg-

ular schedule, select either Custom or Daily as the discovery
Frequency, as shown in the following steps:
Notes:

l Scheduled discovery profiles should not use IP address ranges that
include nodes with dynamically assigned IP addresses (DHCP).

l Default Discovery Scheduling settings execute a single discovery of
your network that starts immediately, once you click Discover.

l Results of scheduled discoveries are maintained on the Scheduled
Discovery Results tab of Network Discovery. For more information
about managing scheduled discovery results, see “Managing Sched-
uled Discovery Results” on page 275.

a. If you want to define a custom discovery schedule to perform the
currently defined discovery repeatedly in the future, select Custom
and then provide the period of time, in hours, between discoveries.

b. If you want your scheduled discovery to run once daily, select
Daily, and then provide the time at which you want your discovery to
run every day, using the format HH:MM AM/PM.
18. If you do not want to run your network discovery at this time,

select No, don’t run now, and then click Save or Schedule,
depending on whether you have configured the discovery to run
once or on a schedule, respectively.

19. If you want your Network Sonar discovery to run now, click Dis-
cover to start your network discovery.
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Note: Because some devices may serve as both routers and
switches, the total number of nodes discovered may be less than
the sum of reported routers discovered plus reported switches dis-
covered.

Using the Network Sonar Results Wizard
The Network Sonar Results Wizard directs you through the selection of nodes for
monitoring opens whenever discovery results are requested. This will happen
either when the Network Sonar Wizard completes or when Import All Results or
Import New Results is clicked for a selected discovery.
The following steps detail the selection of discovered nodes for monitoring in
SolarWinds SAM.

To select the results of a network discovery for monitoring in SAM:

1. On the Device Types to Import page, check the device types you want to
monitor, and then click Next.
Note: If you are not sure if you want to monitor a specific device type,
check the device type in question. Later, you can delete the device using
Web Node Management.

2. On the Volume Types to Import page, check the volume types you want to
monitor, and then click Next.
Note: If you are not sure you want to monitor a specific volume type, check
the volume type in question. Later, you can delete the volume of the selec-
ted type using Web Node Management.

3. If you want to import nodes, even when they are already known to be
polled by another polling engine, check the option in the Allow
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Duplicate Nodes section. For more information about working with mul-
tiple polling engines, see “Managing SolarWinds SAM Polling Engines” on
page 311.

4. If there are any devices on the Import Preview that you do not ever
want to import, check the device to ignore, and then click Ignore. Selec-
ted nodes are added to the Discovery Ignore List. For more information,
see “Using the Discovery Ignore List” on page 276.

5. Confirm that the network objects you want to monitor are checked on the
Import Preview page, and then click Import.
Note: Imported devices display in the All Nodes resource.

Managing Scheduled Discovery Results
The Scheduled Discovery Results tab of Network Discovery provides a list of all
recently discovered, changed, or imported devices on your monitored network.
Results are compared between discoveries and results are listed on this tab. The
following procedure provides guidelines for managing discovery results.

To manage scheduled discovery results:
1. Click Start > All Programs > SolarWinds > Configuration and Auto-

Discovery > Network Discovery.
2. Click Scheduled Discovery Results.
3. Select the type of devices you want to view from the Status menu in the left

pane. The following options are available:
o Select Found to view all devices discovered by a scheduled dis-
covery.

o Select Changed to view all devices that have changed between
recent scheduled discoveries. Changes include the addition of
device configuration changes.

o Select Imported to view all devices you have recently imported to
your SolarWinds database. For more information about importing
devices, see “Using the Network Sonar Results Wizard” on
page 274.

o Select Ignored to view all devices you have added to your Dis-
covery Ignore List. For more information about the Discovery Ignore
List, see “Using the Discovery Ignore List” on page 276.

o Select Found and Changed to view a combined list of all devices
found or changed as described above.
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o Select All except Ignored to view all discovered, changed or impor-
ted devices you have not already designated as Ignored, as
detailed above.

4. If you want to apply a grouping criterion to organize your listed res-
ults, select an appropriate criterion from the Group by menu in the left
pane.

5. If there are changed or discovered nodes in the results list that you
want to add to your SolarWinds database, check them and then click
Import Nodes.

6. If there are devices you want SolarWinds SAM to ignore in future dis-
coveries, regardless of discovered updates or changes, check the
nodes to ignore, and then click Add to Ignore List. For more information
about the Discovery Ignore List, see “Using the Discovery Ignore List” on
page 276.

Using the Discovery Ignore List
Often, devices are found during a network discovery that you never intend to
monitor with SolarWinds SAM. The Discovery Ignore List is a record of all such
devices on your network. By placing a device on the Discovery Ignore List you
can minimize the SNMP processing load associated with discovering devices
that you never intend to monitor.

To manage devices on the Discovery Ignore List:

1. Click Start > All Programs > SolarWinds > Configuration and Auto-
Discovery > Network Discovery.

2. If you want to view the current Discovery Ignore List, click Discovery
Ignore List.

3. If you want to add devices to the Discovery Ignore List, complete the
following procedure:
a. Click Scheduled Discovery Results.
b. Check devices you want to ignore, and then click Add to Ignore List.

4. If you want to remove devices from the Discovery Ignore List, com-
plete the following procedure:
a. Click Scheduled Discovery Results, and then
b. Check the devices you want to remove from the list.
c. Click Remove from Ignore List.
d. Confirm that you want to stop ignoring the selected items by clicking

OK.
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After the Network Sonar Wizard completes the node discovery and imports the
results, you are taken directly to the Application Discovery Wizard to discover
applications to monitor on the nodes.

For more information, see "Application Discovery" on page 278.
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Application Discovery
SolarWinds SAM can scan nodes and automatically assign the Application
Monitors it deems suitable for each scanned node. You control the nodes to be
scanned, the application templates used in the scan, and the scanning
parameters that determine a match.

To Access Application Discovery:

1. Click Settings at the top right of the SolarWinds Web Console.
2. Now click Discovery Central in the Getting Started with SolarWinds cat-

egory.
3. In the Application Discovery category, click Discover Applications to

begin using the wizard-like interface.
For more information, see "Add Application Monitors" on page 280.

Select Nodes

1. Click [+] in the list to expand the node groups and to select the nodes you
want to scan.

2. When you are finished selecting nodes, click Next.

Select Applications

To keep the scanning time to a minimum, we recommend you initially
scan for a limited number of application templates. To see more
application templates, select a different template group from the Show
Only list.
To adjust the template assignment criteria, expand Advanced Scan
Settings and move the slider to the desired setting:

Exact Match
All the components must match to assign the template.

Strong Match
Most of the components must match to assign the template.
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Partial Match
Some of the components must match to assign the template.

Minimal Match
At least one component must match to assign the template.

When you are finished selecting applications, click Next.

Enter Credentials

Some application templates require credentials either to access
restricted resources, or to run within the context of a specific user. To
scan for these templates, add the necessary credentials to the list. If a
template you are scanning for requires credentials, the credentials in
this list are tried in the order in which they appear.

Warning: Credentials are tried several times over the course of a
scan, so an incorrect password is likely to lock out an account. To
avoid potential account lockouts that affect actual users, we
recommend you create and use service accounts. A service account is
an account created specifically for the purpose of providing
credentials to use for SolarWinds monitoring. With service accounts,
no actual user is affected by an account lockout if a password should
be entered incorrectly.

If you have domains sharing user names with different passwords, we
recommend you run separate application discoveries for each domain.

When you are finished entering credentials, click Next.

Review and Start Scan

Review the summary for the scan. If the automatic discovery matches
templates that are already assigned to the node, by default the
template is not assigned a second time. If you want to assign duplicate
templates, select Yes, Assign Anyway from the Do you want to
assign duplicates list.
Click Start Scan to begin the scan. The scan runs in the background.
If you like, click View progress near the light bulb icon toward the top
of the page to view the progress of the scan. You are notified by a
message near the top of the window when scanning is completed.
Click View Results to see the results of the scan. Click View SAM

279



Summary Page (or > SAM Application Summary) to display the
SAM summary page.

Add UX Monitors

You cannot scan for user experience (UX) monitors, but you can
assign them to nodes manually. Adding monitors from this page does
not affect your scan.

Add Application Monitors
After adding individual nodes, you are prompted by the Add Application
Monitors page to add applications for monitoring the desired application(s) on
the new node as described below.

To add Application Monitors on the Add Application Monitors page:

1. Use the Show Only list to select the desired category for the Application
Monitors you want to add.

2. Check the check box next to the Application Monitor(s) you want to assign.
3. The selected Application Monitor(s) are added to the list of Selected applic-

ations.
4. If you change your mind and want to delete an application, click the

red X next to the name of the application in the Selected applications list.
5. If suitable credentials already exist, choose the credential from the

Choose Credential list.
6. If suitable credentials do not exist, choose <New Credential> from the

Choose Credential list, and then add the new credential by filling out the
credential details.

7. Click Test to test the credentials and component monitors against the test
node.

8. If the test fails, troubleshoot the problem based on the error messages,
and then retest the node.

9. Click Next.
10. On the Change Properties page, modify any of the information as

needed, such as the Node Status Polling interval (in seconds) and the
Collect Statistics Every frequency (in minutes).

11. Click OK, Add Node.
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Reading the Application Summary
The SAM Application Summary is the first view displayed after launching Server
& Application Monitor. This view provides insight into application health and
performance conditions over your entire network. The resources listed in this
section are the default views included in the SAM Application Summary.

Active Application Alerts
This resource provides the current application-specific alerts, including the time
the alert fired, the name of the application that caused the alert, and the alert
message. Click the Network Node to see the SolarWinds Node Details view.
Click the Application Name to see the SAM Application Details view.

Application Health Overview
This resource provides a status overview of all your assigned application
monitors. Click a status to list the assigned application monitors in that status.

The following statuses are depicted on the Application Health Overview:

Application Up
Assigned application monitors with all component monitors responding and
operating within their thresholds.

Application Critical
Assigned application monitors with at least one component monitor
operating past the critical threshold.
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Application Down
Assigned application monitors with at least one unresponsive component
monitor.

Application Warning
Assigned application monitors with at least one component monitor
operating past the warning threshold.

Other
Assigned application monitors that are suspended due to licensing
restrictions.

Unknown
Assigned application monitors with status that cannot yet be determined.

Applications with Problems
This resource lists the assigned application monitors reporting any status other
than up.

Last 25 Application Events
This resource provides a list of application-centric events from the time period you
specify. The default time period shows the last 25 application events. Clicking
Edit allows you to change the time period, limiting the events displayed in the
resource.
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Thwack Latest Application Templates
This resource lists the newest application monitor templates that have been
added to the Thwack community web site. Click a template to open its download
web page.

Top 10 Components Monitored by Response Time
This resource provides a list of the component monitors with the slowest
response time.

Top 10 Processes Monitored by CPU Load
This resource provides a list of the component monitors consuming the most
CPU.

Top 10 Processes Monitored by Physical Memory
This resource provides a list of the component monitors consuming the most
physical memory.
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Top 10 Processes Monitored by Virtual Memory
This resource provides a list of the component monitors consuming the most
virtual memory.

Top XX Monitored Processes by I/O Reads/Sec
This resource displays the total number of I/O Read operations per second.

Fields:
l Process Name: Displays the name of the listed process. Clicking a pro-
cess in the list will take you to the Component Details page for that pro-
cess.

l Application Name: Displays the name of the listed application that con-
tains the listed process. Clicking an application in the list will take you to
the Application Details page for that application.
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l Network Node: Displays the name of the listed node that contains the lis-
ted application and process. Clicking a node in the list will take you to the
Node Details page for that node.

l IO Reads: Displays the current rate of Input/Output reads.
Note: Clicking Edit will allow you to change the Title, Sub-Title, and Maximum
Number of Monitors to Display.

Hovering the mouse over any part of this resource will reveal a tooltip with
detailed information about the item listed.

For more information, see the following:

l Top XX Monitored Processes by I/OWrites/Sec
l Top XX Monitored Processes by I/O Total Operations/Sec

Top XX Monitored Processes by I/O Writes/Sec
This resource displays the total number of I/O Write operations per second.

Fields:
l Process Name: Displays the name of the listed process. Clicking a pro-
cess in the list will take you to the Component Details page for that pro-
cess.

l Application Name: Displays the name of the listed application that con-
tains the listed process. Clicking an application in the list will take you to
the Application Details page for that application.

l Network Node: Displays the name of the listed node that contains the lis-
ted application and process. Clicking a node in the list will take you to the
Node Details page for that node.

l IO Writes: Displays the current rate of Input/Output writes.

285



Note: Clicking Edit will allow you to change the Title, Sub-Title, and Maximum
Number of Monitors to Display.

Hovering the mouse over any part of this resource will reveal a tooltip with
detailed information about the item listed.

For more information, see the following:

l Top XX Monitored Processes by I/O Reads/Sec
l Top XX Monitored Processes by I/O Total Operations/Sec

Top XX Monitored Processes by I/O Total Operations/Sec
This resource displays the total number of I/O operations per second.

Fields:
l Process Name: Displays the name of the listed process. Clicking a pro-
cess in the list will take you to the Component Details page for that pro-
cess.

l Application Name: Displays the name of the listed application that con-
tains the listed process. Clicking an application in the list will take you to
the Application Details page for that application.

l Network Node: Displays the name of the listed node that contains the lis-
ted application and process. Clicking a node in the list will take you to the
Node Details page for that node.

l Total IOPS: Displays the current rate of Input/Output.
Note: Clicking Edit will allow you to change the Title, Sub-Title, and Maximum
Number of Monitors to Display.

Hovering the mouse over any part of this resource will reveal a tooltip with
detailed information about the item listed.

For more information, see the following:
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l Top XX Monitored Processes by I/O Reads/Sec
l Top XX Monitored Processes by I/OWrites/Sec

Server Warranty Summary
This resource displays warranties currently expired and set to expire on the
current node. This is done by SAM periodically checking the status of each
server's warranty against Dell, HP, and IBM's online warranty validation servers.

Clicking a node in the summary list will take you the Node Details view for that
node. You can expand and collapse the tree views by clicking [+] and [-]
respectively.

You can visually see warranties nearing their expiration dates by examining the
dates in the Expiration Date column. Also, if a warranty expiration date crosses a
Warning or Critical threshold, progress bars will appear as yellow and red,
respectively. Clicking Edit will allow you to customize threshold values as well as
filter the warranties you want displayed.
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l Expired Warranties: Lists the nodes that currently have expired warranties.
l Warranties Due to Expire: Lists the nodes that have warranties nearing
their expiration date.

l Next 5 Warranties Set to Expire: Lists the top five warranties nearing their
expiration date.

Clicking Edit will allow you to fine tune the information displayed in this resource,
as shown below:

Server Warranty Summary Alerts

One alert is included with Server Warranty Summary:

1. Alert me when a node warranty expires in 30 days - Disabled by default
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SolarWinds Integrated Virtual Infrastructure Monitoring (IVIM) built into
SolarWinds SAM lets you monitor today's modern network fabric of virtual
networks, virtualized data centers, and private clouds. The deep visibility into your
virtualized environments helps you ensure that network performance helps and
not hinders your virtualization projects

SAM is capable of monitoring VMware ESXi and ESX Servers versions 3.5 and
higher as well as Microsoft's Hyper-V up to and including Hyper-V 2012 R2.

Note: A node can either be a VMware ESX/vCenter server or Hyper-V server, not
both.

VMware Monitoring
Monitor your entire VMware virtual infrastructure from the highest to the lowest
level: vCenter → datacenter → cluster → ESX hosts → individual virtual
machines. Track availability and performance metrics including CPU, memory,
storage, and network bandwidth utilization

Virtual Machine Auto-Summary

Automatically discover identify and monitor new virtual machines added to any
VMware host server or updated during vMotion.
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Virtualization Alerting and Reporting

SolarWinds' native alerting and reporting capabilities extend seamlessly to your
virtual infrastructure.

Refer to the following sections for more information:

l Requirements for Monitoring ESXi and ESX Servers
l Managing VMware Credentials in the Web Console
l Adding Virtual Servers for Monitoring
l Virtualization Summary
l Viewing ESX Host Details
l Changing Polling Orders for ESX Servers

Requirements for Monitoring ESXi and ESX Servers
The following table provides minimal requirements for effectively using
SolarWinds SAM to monitor your VMware ESXi and ESX Servers.

Note: SolarWinds SAM uses the VMware API to poll most performance data from
devices running ESX Server versions 3.5 and 4.0. Before SAM can start polling
ESX Servers, you must ensure that you have created credentials on your ESX
Servers for the SAM polling engines. Information on how to do this can be found
here: KB Article 2177.

Credentials created for the SAM polling engines must have read-only rights, at
minimum.

Requirement Description

SNMP SolarWinds SAM uses SNMP to
monitor all ESXi and ESX Servers. For
more information about enabling
SNMP, refer to the following sections:

l Enabling SNMP on VMware
ESXi

l Enabling SNMP on ESX Server
Version 3.5

l Enabling SNMP on ESX Server
Version 4.0

l Creating ESX Server Cre-
dentials for SolarWinds SAM
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VMware API SolarWinds SAM uses the VMware
API to poll most performance data from
devices running ESXi and ESX Server
versions 3.5 and 4.0. For more
information about creating required
credentials, see “Creating ESX Server
Credentials for SolarWinds SAM” on
page 326.

VMware Tools VMware Tools must be installed on all
ESXi and ESX Servers you intend to
monitor. VMware Tools is not required
on virtual machines running on
monitored ESXi and ESX servers, but
additional information, including IP
addresses, are made available when
VMware Tools is installed on virtual
machines hosted by monitored ESXi
and ESX Servers.

The following table provides a summary of the methods used by SolarWinds SAM
to monitor VMware ESX Servers.

Notes:
l Both SAM and NPM share the same VIM module, so their monitoring meth-
ods are identical.

l VIM gathers Network utilization information via VMware API, but not indi-
vidual interfaces (e.g. Interfaces under “List Resources”) or interface status
(Up/Down). Interface status is only available via SNMP, which is part of
NPM.

3.5 3i 4 4i

Detection as ESX Server VMware API

Volumes SNMP N/A SNMP N/A
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Interfaces SNMP N/A SNMP SNMP (partial)

CPU SNMP N/A SNMP SNMP

Memory SNMP N/A SNMP SNMP

Total Memory VMware API

Guest VM List VMware API

Enabling SNMP on VMware ESXi and ESX Servers
SolarWinds SAM uses SNMP to poll performance data from VMware ESXi and
ESX Servers. In order to make this performance data available to SolarWinds
SAM, you must enable SNMP on your VMware ESXi and ESX Servers, as
described in the following sections:

Note: VMware only makes a limited amount of information available to SNMP
queries for VMware ESXi and ESX Servers version 4.0 and higher. To access
additional information on these versions, SolarWinds SAM utilizes the VMware
API.

Enabling SNMP on VMware ESXi
The following procedure enables SNMP on VMware ESXi:

Note: The following procedure to enable SNMP requires the vSphere command
line interface (CLI). The vSphere CLI is not packaged with your ESXi Server by
default, so you will need to download it from VMware, as indicated.

To enable SNMP on VMware ESXi:

1. Download and install the VMware vSphere command line interface from the
VMware Download Center (http://downloads.vmware.com/d/).

2. Use the vSphere CLI to view your ESXi server SNMP settings, as indicated
in the following procedure:

a. In the Perl\bin directory of your vSphere installation, execute the fol-
lowing script:
perl ..\..\bin\vicfg-snmp.pl --server ip_address –s

Notes:
l C:\Program Files\VMware\VMware vSphere CLI\Perl\bin is the default
location of the vSphere Perl\bin directory.
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l Replace ip_address with the IP address of your ESXi server,
and replace cstring with the community string you are adding.
For most environments, the community string public should be
sufficient.

b. Enter an appropriate user name at the prompt.

Note: For most environments, root should be sufficient.
c. Enter the associated password at the prompt.

3. Use the vSphere CLI to enable SNMP on your ESXi server, as indicated in
the following procedure:

a. In the Perl\bin directory of your vSphere installation, execute the fol-
lowing script to add an appropriate community string:

perl ..\..\bin\vicfg-snmp.pl --server ip_address -c cstring

Note: Replace ip_address with the IP address of your ESXi server,
and replace cstring with the community string you are adding. For
most environments, the community string public should be sufficient.

b. Enter an appropriate user name at the prompt.

Note: For most environments, root should be sufficient.
c. Enter the associated password at the prompt.
d. In the Perl\bin directory of your vSphere installation, execute the fol-

lowing script to enable SNMP:

perl ..\..\bin\vicfg-snmp.pl --server ip_address –E

Note: Replace ip_address with the IP address of your ESXi server.

e. Enter an appropriate user name at the prompt.

Note: For most environments, root should be sufficient.
f. Enter the associated password at the prompt.

4. Reboot your ESXi server to allow settings to take effect.

Enabling SNMP on ESX Server Version 3.5
The following procedure enables SNMP on ESX Server version 3.5.

Note: For more information about ESX Server 3.5 and ESX Server MIBs, see the
VMware document, “Basic System Administration - ESX Server 3.5, ESX Server
3i version 3.5, VirtualCenter 2.5.”
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To enable SNMP on ESX Server version 3.5:

1. Log in to your ESX Server using an account with administrative privileges.

2. Open snmpd.conf in a text editor.

Notes:
l The default location for snmpd.conf is root/etc/snmp/snmpd.conf.
l To use the default text editor, nano, in a default ESX Server version
3.5 environment, enter nano /etc/snmp/snmpd.conf at the prompt.

3. Locate the rocommunity setting and replace the default community string
public with an appropriate read-only community string for your environment.

Note: Use commas to separate multiple community strings.
4. Save snmpd.conf, and then close your editor.

Note: If you are using nano, press Ctrl+X to close nano, and then enter Y to
save snmpd.conf.

5. Enter chkconfig snmpd on to enable SNMP when you reboot your ESX
Server.

6. Enter esxcfg-firewall -e snmpd to allow SNMP through the ESX Server
firewall.

7. Enter service snmpd start to start the SNMP service.

8. Confirm that SNMP polling is enabled on your ESX Server by entering the
following command:

snmpwalk -v1 -c cstring localhost .1.3.6.1.4.1.6876 | grep 6876.1

Note: Replace cstring with the community string you provided above.
9. After entering the snmpwalk command, your ESX Server should return

information similar to the following:
SNMPv2-SMI::enterprises.6876.1.1.0 = STRING: "VMware ESX Server"

SNMPv2-SMI::enterprises.6876.1.2.0 = STRING: "3.5.0"

SNMPv2-SMI::enterprises.6876.1.3.0 = OID: SNMPv2-SMI::enterprises.6876.60.1.3.5.0

SNMPv2-SMI::enterprises.6876.1.4.0 = STRING: "153875"

Note: The MIB OID SNMPv2-SMI::enterprises.6876.1.4.0 returns the build
number for your product, so it may not be the same as the build number
displayed above.
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Enabling SNMP on ESX Server Version 4.0
The following procedure enables both the system default SNMP daemon snmpd
and the proprietary VMware SNMP daemon vmware-hostd on VMware ESX Server
version 4.0:

Note: For more information about ESX Server 4.0 and ESX Server MIBs, see the
VMware document, “vSphere Basic System Administration - Update 1, ESX 4.0,
ESXi 4.0, vCenter Server 4.0.”

To enable SNMP on ESX Server version 4.0:

1. Log in to your ESX Server using an account with administrative privileges.

2. Open snmp.xml in a text editor.

Notes:
l The default location for snmp.xml is root/etc/vmware/snmp.xml.
l To use the default text editor, nano, in a default ESX Server version
4 environment, enter nano /etc/vmware/snmp.xml at the prompt.

3. Locate the communities tag, and then replace the default community string
public with an appropriate read-only community string for your environment.

Note: Use commas to separate multiple community strings.
4. Locate the enable tag, and then confirm it is set to true.

5. Locate the port tag and confirm it is set to 171.

6. Locate the targets tag and confirm it is set to 127.0.0.1@162/cstring.

Note: Replace cstring with the community string you provided above.
7. Save snmp.xml, and then close your editor.

Note: If you are using nano, press Ctrl+X to close nano, and then enter Y to
save snmp.xml.

8. Enter service snmpd stop to confirm that the SNMP service is stopped.

9. Open snmpd.conf in a text editor.

Notes:
l The default location for snmpd.conf is root/etc/snmp/snmpd.conf.
l To use the default text editor, nano, in a default ESX Server version
4 environment, enter nano /etc/snmp/snmpd.conf at the prompt.

10.
Edit snmpd.conf to include the following two lines:
view systemview included .1.3.6.1.4.1.6876
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proxy -v 1 -c cstring 127.0.0.1:171 .1.3.6.1.4.1.6876

Note: Replace cstring with the community string you provided above.
11. Save snmpd.conf, and then close your editor.

Note: If you are using nano, press Ctrl+X to close nano, and then enter Y to
save snmpd.conf.

12. Enter service mgmt-vmware restart to restart the mgmt-vmware service.

13. Enter service snmpd start to start the SNMP service.

14. Enter chkconfig snmpd on to enable SNMP when you reboot your ESX
Server.

15. Enter esxcfg-firewall -e snmpd to allow SNMP through the ESX Server
firewall.

16. Confirm that SNMP polling is enabled on your ESX Server by entering the
following command:

snmpwalk -v1 -c cstring localhost .1.3.6.1.4.1.6876 | grep 6876.1

Note: Replace cstring with the community string you provided above.
17. After entering the snmpwalk command, your ESX Server should return

information similar to the following:
SNMPv2-SMI::enterprises.6876.1.1.0 = STRING: "VMware ESX"

SNMPv2-SMI::enterprises.6876.1.2.0 = STRING: "4.0.0"

SNMPv2-SMI::enterprises.6876.1.4.0 = STRING: "208167"

Note: The OID SNMPv2-SMI::enterprises.6876.1.4.0 returns your product build
number, so it may not be the same as the build number above.

Creating ESX Server Credentials for SolarWinds SAM
SolarWinds SAM uses the VMware API to poll most of its performance data from
devices running ESX Server versions 3.5 and 4.0. You must create credentials on
your ESX Servers for the SolarWinds SAM polling engine, as shown in the
following procedure:

Note: Credentials created for the SolarWinds SAM polling engine must have
read-only rights as a minimum.
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To create ESX Server credentials for SolarWinds SAM:

1. Log in to your ESX Server using an account with administrative privileges.

Note: Typically, the root user name and password is sufficient.

2. If you are prompted with an untrusted SSL certificate warning, click
Ignore to continue using the current SSL certificate.

3. Open the Users & Groups tab, and then click Users.
4. Right-click the Users view, and then click Add.
5. On the Add New user window, complete the following procedure:

Note: The User Name and Password provided in this step must be
provided either in your initial network discovery or whenever you use Web
Node Management to add the current ESX Server to SolarWinds SAM for
monitoring.

a. Provide both a Login and a User Name for the SolarWinds SAM
polling engine.

b. Enter and confirm a Password.
c. Click OK.

6. Open the Permissions tab.
7. Right-click the Permissions view, and then click Add Permission.
8. On the Assign Permissions window, click Add.
9. Select the user you just created, and then click Add.
10. Click OK on the Select Users and Groups window.
11. Select an appropriate role in the Assigned Role area, and then click OK on

the Assign Permissions window.

The credential you have created is now available to use for monitoring your ESX
Server. For more information about adding your ESX Server to the SolarWinds
database for monitoring, see “Managing VMware Credentials in the Web
Console” on page 327.

Managing VMware Credentials in the Web Console
If you have to update the user name or password of a VMware credential, you can
do so from the VMware Credentials Library tab.

To update a VMware credential:

1. Log in to the web console.
2. Click Settings.
3. Click Virtualization Settings in the Node & Group Management section.
4. Click the VMware Credentials Library tab.
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5. Check the credential you need to update, and then click Edit Credential.
6. Make the necessary updates, and then click OK.

Adding Virtual Servers for Monitoring
VMware Vcenter, ESX servers, and Hyper-V virtual machines are added to the
SolarWinds database in the same ways other devices are added for monitoring in
the SolarWinds Web Console

Polling for VMware nodes Using the Network Sonar Wizard

The Network Sonar Wizard is the recommended method for adding VM Servers
for monitoring in the SolarWinds Web Console. With Network Sonar Discovery,
you can define all required credentials at once on the Local ESX Credentials for
Vmware view. For more information, see "Virtualization Discovery" on page 267.

Adding VMs from the Virtualization Assets Resource

1. Log in to the web console.
2. Point to the Virtualization tab and then click Virtualization Summary.
3. Click the [+] next to any ESX or Vcenter server listed in the Virtualization

Assets resource to expand the list of virtual machines.
4. Click a virtual machine that is not currently managed by SolarWinds.

Unmanaged VMs are listed in italic type.
5. Click Yes, Manage this Node.
6. If the VM is not running, manually enter the IP address of the VM in the

Hostname or IP Address field.
7. Check any additional options required to monitor the VM, and then click

Next.
8. Follow the remainder of the Add Node wizard to completion, and then click

OK, Add Node.

Virtualization Summary
The Virtualization Summary view shows the overall status of your virtualized
infrastructure.

To view the Virtualization Summary:

1. Log in to the SolarWinds Web Console.
2. Point to the Virtualization tab and then click Virtualization Summary.

The Virtualization Summary view is pre-configured to display the following
resources:
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Top XX Hosts by CPU Load Top XX Hosts by Number of Running
VMs

Top XX Hosts by Percent Memory
Used

Top XX Hosts by Network Utilization

VMware Assets VMware Asset Summary

Hyper-V Assets Hyper-V Asset Summary

To change the properties or contents of any resource, click Edit in the resource
box.

Viewing ESX Host Details
The ESX Host Details page is displayed when you click an ESX Host server in
the Virtualization Summary. This page is pre-configured to display the following
resources:

Active Alerts on this Node Availability Statistics

Average Response Time & Packet
Loss Graph

Average Response Time & Packet
Loss Gauge

CPU Load & Memory Utilization Gauge Disk Volumes

ESX Host Details Event Summary

List of Virtual Machines Min/Max AverageCPU Load Graph

Node Details Polling Details

Virtual Machine CPU Consumption Virtual Machine Memory Consumption

Virtual Machine Network Traffic

To change the properties or contents of any resource, click Edit in the resource
box.

Changing Polling Orders for ESX Servers
If your VMware ESX hosts are controlled by VMware vCenter servers,
SolarWinds obtains the status of the ESX hosts from the vCenter server instead of
polling the ESX hosts directly.
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To poll the ESX servers directly you must change the Poll Through setting of the
ESX host from the Virtualization Settings page. From this page, you can also
disable and enable polling for ESX hosts and vCenter servers.

To poll a vCenter-managed ESX Host from the SolarWinds server:

1. Log in to the web console.
2. Click Settings.
3. Click Virtualization Settings in the Node & Group Management section.
4. Point to any column heading, click the upside-down triangle, and then click

Columns > Polling Through.
5. Select the ESX hosts you want to poll directly.
6. Click Poll Through > Poll ESX server directly.

Troubleshooting ESX Hardware Monitoring
When an ESX server returns the message, Unable to connect to remote server,
check the following:

l Ensure CIM is enabled on the ESX server. To enable CIM on ESX/ESXi,
refer to the following section: "Hardware Monitoring and VMware" on page
835.

l Ensure port 5989 is opened on the firewall
If the ESX server returns the message, Unable to establish session with all
provided credentials, check the following:

l Verify the VMware credentials in the VIM are correct
l Verify the account belongs to the root user group

Hyper-V Monitoring
SAM  natively supports monitoring of Microsoft's Hyper-V server and its guests.
By default, the statistic collection interval is set to ten minutes.

Note: A node can either be a VMware ESX/vCenter server or Hyper-V server, not
both.
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Requirements for Monitoring Hyper-V Servers
The following table provides minimal requirements for effectively using
SolarWinds SAM to monitor your Hyper-V Servers:

Requirement Description

Hyper-V version All versions of Hyper-V are
supported, up to and
including Hyper-V 2012 R2.

WMI SolarWinds SAM uses WMI
to monitor all Hyper-V
Servers. SNMP is not
supported when monitoring
Hyper-V servers. For more
information about enabling
WMI, refer to the following
section: Testing Local WMI
Services on page 1325.

Note: If switching from SNMP
to WMI to monitor a Hyper-V
server, certain previously
monitored data will be lost as
a result of the protocol
change.

For example: If you have
NPM installed and are
monitoring an interface via
SNMP, switching to WMI to
monitor Hyper-V will cause
the interface's historical data
to be lost. You can either
monitor Hyper-V via WMI or
an interface via SNMP, not
both.

Number of Virtual SolarWinds recommends
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Machines fewer than 1,000 virtual
machines running on any one
Hyper-V server.

Configuring Hyper-V Servers for Discovery
For data collection and inspection of Microsoft Windows Hyper-V hosts through
Windows Management Instrumentation (WMI), each server running Hyper-V
requires:

1. A user account with elevated credentials
2. Changes to the firewall

The following table lists the discovery requirements in detail.

Item Need

User
Account

Depending on your implementation, supply one of the following as
credentials for the credentials database:

l For domain-based authentication, a domain account with
membership in the Administrators group on the monitored
application server.

l For workgroup authentication, a built-in administrator
account on the monitored application server

l For workgroup authentication, a local user account with mem-
bership in the Administrators group and the User Account
Control (UAC) setting "Run all administrators in Admin
Approval Mode" disabled on the monitored application
server.

Windows
Firewall

Ensure that core networking, Windows Management
Instrumentation (WMI), and RPC traffic can traverse the firewall. 

Modifying the Windows Firewall

You must allow core networking, WMI, and RPC traffic through the firewall of the
monitored server. The following procedure walks you through allowing this traffic
through the Windows Firewall on Windows 2008 R2.

Notes:
l If you have restricted the range of dynamic RPC ports, you must ensure
that each host is able to access that port range.
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l If you are connecting to Hyper-V hosts through a DMZ or hardware firewall,
you must open the corresponding rules and ports on the hardware.

To allow the correct traffic through the Windows firewall, you must perform the
following steps:

1. Ensure the core networking rules are enabled
2. Enable the Windows Management Instrumentation (DCOM-In) rule
3. Create a new rule to open the RPC ports

Ensure the Core Networking rules are enabled

You must ensure that the core networking rules are enabled to collect information
successfully from Hyper-V hosts.

Note: If the rule has a green icon with a checkmark in front of it, the rule is
enabled.

To allow core networking traffic through the Windows Firewall on Windows
2008 R2:

1. Log on to the computer you want to monitor with an administrator
account.

2. Navigate to Start > Administrative Tools >Windows Firewall with
Advanced Security.

3. Click Inbound Rules in the left navigation pane.
4. Ensure that all Core Networking rules are enabled. If not, select the

disabled rule and then click Enable Rule in the Action menu.

Enable the Windows Management Instrumentation (DCOM-In) rule

You must ensure that theWindows Management Instrumentation (DCOM-In)
rule is enabled to collect information successfully from Hyper-V hosts.

Note:  After enabling the Windows Management Instrumentation (DCOM-In) rule,
common WMI checks indicate that WMI is not enabled. This is expected behavior.

To allowWMI traffic through the Windows Firewall on Windows 2008 R2:

1. Log on to the computer you want to monitor with an administrator
account.

2. Navigate to Start > Administrative Tools >Windows Firewall with
Advanced Security.

3. Click Inbound Rules in the left navigation pane.
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4. ClickWindows Management Instrumentation (DCOM-In), and then
click Enable Rule in the Action menu.

Create a new firewall rule to open the RPC ports

You must open the RPC ports to collect information successfully from Hyper-V
hosts. This is best done by creating a new firewall rule.

To open the RPC ports on Windows 2008 R2:

1. Log on to the computer you want to monitor with an administrator
account.

2. Navigate to Start > Administrative Tools > Windows Firewall with
Advanced Security.

3. Click Inbound Rules in the left navigation pane.
4. Click Actions > New Rule…
5. In Rule Type, select Custom and click Next.
6. Select This program path and enter %SystemRoot%\System32\dllhost.exe

in the text box.
7. In Services, click Customize to ensure that Apply to all programs and

services is selected, and click OK.
8. Click Next
9. In Protocol type, select TCP.
10. In Local port, select RPC Dynamic Ports.
11. In Remote port, select All Ports.
12. Click Next.
13. Apply to any local and remote IP addresses and click Next.
14. In Action, ensure that Allow the connection is selected and click Next.
15. Select all profiles (Domain, Private, and Public) and click next.
16. Enter a name, such as SAM WMI Dynamic Ports.
17. Click Finish

The new rule will now appear in the list of inbound rules.

Enabling and Disabling Hyper-V Monitoring
Hyper-V monitoring is automatically enabled on WMI nodes after a Network
Sonar Discovery is run. For information on enabling WMI, see "Testing Local WMI
Services" on page 1325.

There are two ways to toggle Hyper-V monitoring; via the Manage Nodes page,
and through the Virtualization Summary resource.
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Warning: If Hyper-V polling is disabled, all historical data will be lost. To retain
historical data, use the Virtualization Summary method and select Unmanage.

List Resources Method:

1. From the web console, click Settings in the upper right-hand corner of the
screen.

2. In the Node & Group Management resource, click Manage Nodes.
3. Select the desired node by checking it, and then click List Resources.
4. Check or uncheck Hyper-V, if available.

Virtualization Summary Method:

Warning: If Hyper-V polling is disabled, historical data will be lost. To retain
historical data, select Unmanage. When you choose to remanage the node, all
historical data will be available.

1. In the web console, click the Virtualization tab.
2. In the Virtualization Assets resource. Click Virtualization Settings.

3. In Virtualization Settings, click the Hyper-V tab.
4. Click List Resources.
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Note: You can temporarily enable/disable polling of Hyper-V by selecting
a node from the list and clicking either Disable Hyper-V Polling or Enable
Hyper-V Polling. If you check a disabled node, the Enable Polling button
will become enabled. The converse is also true.

5. Check or uncheck Hyper-V and then click Submit.

Accessing Hyper-V Details
Hyper-V is incorporated into multiple resources found in SAM's web console on
the Virtualization tab. Following is just one example:

Virtualization Assets:

With Hyper-V being native to SAM, you can drill down to the Node Details page
from this view. If the node in this view is not managed, you will be prompted to go
to the Add Node wizard to have this node managed.
Clicking Edit will allow you to filter the vendors that are shown in this view.
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AppInsight Applications
AppInsight applications provide a level of detail and expert knowledge far beyond
what a simple template can provide, allowing you to monitor virtually every aspect
of the assigned application.

Like any unassigned application in SAM, AppInsight applications are considered
templates until applied. Therefore, it is a member of the Application Monitor
Templates collection.

Once applied to a node, AppInsight applications are considered applications.
Like any SAM application, AppInsight applications are comprised of multiple
component monitors, also known as performance counters.

Currently, SAM offers two different AppInsight Applications:

l AppInsight for SQL
l AppInsight for Exchange

Template/Application Relationship
The following illustration explains the Template and Application relationship and
is true for all templates, including all AppInsight applications.

Here you can see that if you change something at the template level, the
applications based on that template will be affected. Conversely, if you change
something on the application level, only the individual application will be affected.

This inheritance relationship is beneficial if you need to make a great deal of
changes quickly. For example, rather than change one item on 100 applications
that are based on a single template (which requires 100 changes), you can more
easily change the one item on the template. That one change in the template will
trickle down to all 100 applications that are based on the template.
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AppInsight for SQL
SAM offers a detailed view of your SQL databases' performance without the use
of agents or templates by using the AppInsight for SQL embedded application.
AppInsight for SQL provides a level of detail and expert knowledge† far beyond
what a SQL template can provide, allowing you to monitor virtually every aspect
of your SQL instances and databases.

Like any unassigned application in SAM, AppInsight for SQL is considered a
template until it is applied. Therefore, it is a member of the Application Monitor
Templates collection.
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Once applied to a node, AppInsight for SQL is considered an application. Like
any SAM application, AppInsight for SQL is comprised of multiple component
monitors, also known as performance counters.

AppInsight for SQL general information:
l AppInsight for SQL Requirements and Permissions
l AppInsight for SQL Licensing
l Template/Application Relationship
l Adding AppInsight for SQL to a Node
l Editing the AppInsight for SQL Template
l Understanding the AppInsight for SQL Details View
l Navigating the AppInsight for SQL Details View

Information about individual AppInsight for SQL resources can be found at
the following locations:

l AppInsight for SQL Details view, which is comprised of the following sub-
views:

o AppInsight for SQL Details View (Summary Tab)
o AppInsight for SQL Details View (Queries Tab)
o Database Details View

l Performance Counter Details View

_________________
† Portionsof the performance counter information used in theAppInsight for SQL application are provided courtesyof
multiple sources listed in the copyright and attribution section at the beginning of this document.

AppInsight for SQL Requirements and Permissions
AppInsight for SQL data is collected at the same default five minute polling
interval as traditional application templates. Following are the requirements and
permissions needed for AppInsight for SQL:

Important: AppInsight for SQL does not require named-pipes; however, it does
require TCP. For example, SAM uses TCP detection during discovery. You may
receive an error message pertaining to "named-pipes.“ This is the result of the the
last client protocol that is tried during connection to the SQL server.

AppInsight for SQL Requirements

AppInsight for SQL supports the following versions of Microsoft SQL Server:

Microsoft SQL Server Version Versions Supported
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Microsoft SQL Server 2008 Without SP

SP1

SP2

SP3

Microsoft SQL Server 2008 R2 Without SP

SP1

SP2

Microsoft SQL Server 2012 Without SP

SP1

AppInsight for SQL Permissions

The minimum SQL permissions required to use AppInsight for SQL are as
follows:

l Must be a member of the db_datareader role on the msdb system data-
base.

l Must have VIEW SERVER STATE permissions.
l View any definition.
l Connect permission to Master database.
l Execute permission on the Xp_readerrorlog stored procedure.
l Connect permission to the Msdb database.
l Must be member of db_datareader role in the Msdb database.
l Connect permission to all databases.

Note: AppInsight for SQL supports both the SNMP and WMI protocols and uses
SQL to gather information about the application. Additional information is
available for nodes managed via WMI.

The following script will configure permissions: 

USE master

GRANT VIEW SERVER STATE TO AppInsightUser

GRANT VIEW ANY DEFINITION TO AppInsightUser

GRANT VIEW ANY DATABASE TO AppInsightUser
EXEC sp_adduser @loginame = 'AppInsightUser' ,@name_in_db =

'AppInsightUser'

GRANT EXECUTE ON xp_readerrorlog TO AppInsightUser

USE msdb
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EXEC sp_adduser @loginame = 'AppInsightUser' ,@name_in_db =

'AppInsightUser'
EXEC sp_addrolemember N'db_datareader', N'AppInsightUser'

AppInsight for SQL Licensing
When using AppInsight for SQL, 50 component monitors will count against your
licensed number of component monitors per SQL instance.

For example, if you have an active license for 1,500 component monitors and
use AppInsight for SQL to monitor 88 databases over ten instances of SQL, 500
component monitors will count against your total license. The number of
databases you have on these instances is irrelevant.

(50 component monitors X 10 SQL Server instances = 500 component
monitors used.)

This will leave you with 1,000 component monitors available for use elsewhere.

(1,500 component monitors – 500 component monitors used for
AppInsight for SQL = 1,000 component monitors remaining).

There is no restriction on the number of databases you can have monitored. Also
note that if you choose not to use this application, you will not be penalized any
number of component monitors.

For more information, see "Licensing" on page 150.

Adding AppInsight for SQL to a Node
There are multiple ways to add AppInsight for SQL to a node, via Node
Discovery, manually adding it via the Manage Application Monitor Templates
screen, adding it via the Management resource, adding it via Network Sonar
Discovery, or adding it via a Scheduled Discovery.
To Add AppInsight for SQL to a Node via Discovery:

1. From the web console, navigate to Settings > Add a Node in the Getting
Started with Orion section.
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2. Fill out the information on the Define Node step, and then click Next.
3. On the Choose Resources step, check the AppInsight for SQL applic-

ations you want. AppInsight applications have a unique blue and white
icon, as shown:

4. Click Next and complete the wizard as instructed.
To Add AppInsight for SQL to a Node via Manage Application Templates:

1. From the web console, navigate to Settings > SAM Settings > Manage
Templates.
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2. Select AppInsight for SQL by checking its box and click Assign to Node.
3. Complete the required fields in the wizard and click Assign Application

Monitor.

To Add AppInsight for SQL via the Management Resource:

1. Navigate to the Node Details view by clicking any node.
2. From the Management resource, click List Resources.
3. Check the AppInsight for SQL box to enable AppInsight for SQL data

collection. 

For information on Network Sonar Discovery, see Network Sonar Discovery.

For information on Scheduled Discovery, see Managing Scheduled Discovery
Results.

Editing the AppInsight for SQL Template
The AppInsight for SQL application behaves like any other application in SAM.
And like other applications, AppInsight for SQL's template can be edited.

Editing the AppInsight for SQL Template:

1. From the web console, navigate to Settings > SAM Settings > Manage
Templates.

2. Check the AppInsight for SQL template in the list and then click Edit.
3. From here, you can edit any and all component monitors within the tem-

plate; including threshold values, number of records to retrieve, component
monitor description, and so on.
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4. When done editing, click Submit at the bottom of the screen.

Understanding the AppInsight for SQL Details View
The AppInsight for SQL Details view is the equivalent of the Application Details
view of a traditional SAM application; however, there are some notable
differences:

l Details View - Unlike a traditional Application Details view, the AppInsight
for SQL Details view is comprised of two tabs, or sub-views, that host a vari-
ety of resources and information:

o Summary Tab – This view displays an informative summary about
the current SQL instance.

o Queries Tab – This view displays details about the most expensive
queries running across all databases on the current SQL instance.
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l Database Details View - This view displays details about the selected data-
base.

l Performance Counter Details View - This view displays details about the
selected performance counter.

From here, you can select from the dropdown menu and choose to display
different amounts of data based on a time range, as shown below:

Editing Resources

Both the titles and subtitles of each resource can be changed by clicking Edit in
the upper right-hand corner of any resource, and then clicking Submit.
The time and date displayed at the top of each resource (where applicable)
shows the range of data currently loaded into the resource. This, along with the
Sample Interval Range, can be changed by clicking Edit from within the resource.

Additionally, certain resources will allow you to add and remove component
monitors from the resource. You can do this by clicking the Edit button, and then
checking the component monitors you want to keep.
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Bulk Copy
Throughput/
Sec

Definition:
This monitor returns the amount of data bulk copied (in
kilobytes) per second.

Possible problems:
Overall throughput will mostly be limited by your I/O
subsystem.

Zooming
You can have the chart show a predetermined time period of data by clicking on
any one of the three Zoom buttons in the head of the Zoom column. Alternatively,
you can have the chart show a specific date range by dragging the mouse over an
area of the chart. The time and date displayed at the top of the resource shows
the amount of data currently loaded into the chart. This can be changed by
clicking Edit from within the resource.

Note: The Value from Last Poll column shows the most recent data available for
the listed statistic.

AppInsight for Exchange
AppInsight for Exchange was designed exclusively for the mailbox role which
offers a detailed view of your Exchange environment. This application provides
detailed metrics on mailboxes, databases, and a host of performance counters
without the use of agents or templates. AppInsight for Exchange's level of detail
and expert knowledge† goes far beyond what an Exchange template can provide,
allowing you to monitor virtually every aspect of your Exchange environment.

Like any unassigned application in SAM, AppInsight for Exchange is considered
a template until it is applied. Therefore, it is a member of the Application Monitor
Templates collection.

Once applied to a node, AppInsight for Exchange is considered an application.
Like any SAM application, AppInsight for Exchange is comprised of multiple
component monitors.

Note: To optimize your Exchange server performance, see 5 Tips to Optimize
Exchange Server for Improved Performance.

AppInsight for Exchange General Information:
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l AppInsight for Exchange Requirements and Permissions
l AppInsight For Exchange Licensing
l Template/Application Relationship
l Adding AppInsight for Exchange to a Node
l Editing the AppInsight for Exchange Template
l Understanding the AppInsight for Exchange Details Views
l Navigating the AppInsight for Exchange Details Views

_________________
† Portionsof the performance counter information used in theAppInsight for Exchange application are provided courtesyof
multiple sources listed in the copyright and attribution section at the beginning of this document.

AppInsight For Exchange Licensing
When using AppInsight for Exchange, 50 component monitors will count against
your licensed number of component monitors, per Exchange Server.

For example, if you have an active license for 1,500 component monitors and use
AppInsight for Exchange to monitor 88 mailboxes over ten Exchange servers, 500
component monitors will count against your total license. The number of
mailboxes you have on these servers is irrelevant.

(50 component monitors X 10 Exchange Servers = 500 component
monitors used.)

This will leave you with 1,000 component monitors available for use elsewhere.

(1,500 component monitors – 500 component monitors used for
AppInsight for Exchange = 1,000 component monitors remaining).

There is no restriction on the number of mailboxes you can have monitored. Also
note that if you choose not to use this application, you will not be penalized any
number of component monitors.

For more information, see "Licensing."

Quick Configuration and Navigation
Configuration of SAM's AppInsight for Exchange is most easily achieved via
Discovery, as shown below.

l To add AppInsight for Exchange, see Adding AppInsight for Exchange to a
Node
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AppInsight for Exchange Requirements and Permissions
l Local administrator permissions are needed for automatic configuration, but
they are not needed for monitoring once configuration is complete.

l To provide organization-wide capability, the service account (Domain
User) needs to be a member of the View-Only Organization Management
group. Membership to this group gives the user object read-only access to
the entire Exchange environment, without providing any domain or local
access on the Exchange server. It also prevents possible abuse by an unau-
thorized user accessing the account (e.g. modifying Exchange environment
configuration, creating/deleting users, and so on.)

l In order to gather information, the user object must be assigned the Mailbox
Search management role within Exchange. In order for the account to be
configured correctly, the account must be a member of the Local Admin-
istrators group.

For more information, see Troubleshooting Permissions.

Adding AppInsight for Exchange to a Node

There are multiple ways to add AppInsight for Exchange to a node. This can be
done via Node Discovery, adding it via the Management resource, adding it via
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Network Sonar Discovery, or adding it via a Scheduled Discovery.

It is recommended that you add this application on WMI managed nodes. If you
convert an SNMP managed node to SNMP, interface statistics will be lost. To
convert SNMP managed nodes to WMI, see Promoting a Node to WMI Monitoring

Notes:
l Multiple instances of Exchange on the same server is not supported.
l Nodes that are not added via WMI will not appear in the List Resources dia-
log.

l Monitoring an Exchange Database Access Group (DAG) via a Virtual
IP address (VIP) is not supported. AppInsight for Exchange should only be
applied to the physical IP address of each mailbox server in the DAG indi-
vidually.

AppInsight for Exchange Requirements and Permissions
l Local administrator permissions are needed for automatic configuration, but
they are not needed for monitoring once configuration is complete.

l To provide organization-wide capability, the service account (Domain
User) needs to be a member of the View-Only Organization Management
group. Membership to this group gives the user object read-only access to
the entire Exchange environment, without providing any domain or local
access on the Exchange server. It also prevents possible abuse by an unau-
thorized user accessing the account (e.g. modifying Exchange environment
configuration, creating/deleting users, and so on.)

l In order to gather information, the user object must be assigned the Mailbox
Search management role within Exchange. In order for the account to be
configured correctly, the account must be a member of the Local Admin-
istrators group.
Note: For Exchange access this is not required, but in order to modify
Exchange and WinRM settings on the server, as well as to poll performance
counters, this additional level of permission is required.

To Add AppInsight for Exchange via the Management Resource:
1. Navigate to the Node Details view by clicking any Windows node.
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2. From the Management resource, click List Resources.

3. Check the Microsoft for Exchange Server box to enable AppInsight Applic-
ations data collection.

4. Navigate to the All Applications resource to verify the addition.

5. Enter your Exchange credentials when prompted, and then click Configure
Server.
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To Add AppInsight for Exchange to a Node via Discovery:
1. From the web console, navigate to Settings > Add a Node in the Getting

Started with Orion section.

2. Complete the information on the Define Node step, and then click Next.
3. On the Choose Resources step, check the AppInsight for Exchange

applications you want. AppInsight applications have a unique blue and
white icon, as shown:
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4. Click Next and complete the wizard as instructed.
5. Navigate to the All Applications resource and click your application.

6. Enter your Exchange credentials when prompted, and then click Configure
Server.
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For information on Network Sonar Discovery, see:
l Network Sonar Discovery.
l Managing Scheduled Discovery Results.

Understanding the AppInsight for Exchange Details Views

AppInsight for Exchange has multiple Details views. These views are the
equivalent of the Application Details view of a traditional SAM application. There
are four main views:

l The AppInsight for Exchange Details view: This view displays a broad over-
view of the application.

l The Performance Counter Details View: This view displays details about
the selected performance counter.

l The Database Details View: This view displays details about the selected
database.

l The Mailbox Details View . This view displays details about the selected
mailbox.

From the AppInsight for Exchange Details view, you can select from
the dropdown menu and choose to display different amounts of data
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based on a time range, as shown below:

Editing Resources
Both the titles and subtitles of each resource can be changed by clicking Edit in
the upper right-hand corner of any resource, and then clicking Submit.

Note: As illustrated above, other options may appear depending upon the
resource being edited.

For more information, see:
l AppInsight for Exchange Details View
l Performance Counter Details View
l AppInsight for Exchange Database Details View
l AppInsight for Exchange Mailbox Details View

Navigating the AppInsight for Exchange Details Views

AppInsight for Exchange acts like any other application and can therefore be
found in the All Applications resource on the Application Summary view.
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Below is the AppInsight for Exchange application within the All Applications
resource on the Application Details page:

To Navigate to the AppInsight for Exchange Details View:
1. From the web console, locate the All Applications resource.
2. Expand the AppInsight for Exchange tree by clicking [+].
3. Expand the node tree by clicking [+].
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4. Click the application, as highlighted:

To Navigate to the Performance Counter Details view:
1. From the AppInsight for Exchange Details view, click any performance

counter within a resource, as highlighted:

To Navigate to the Database Details view:
1. From the AppInsight for Exchange Details view, click any database within a

Database resource, as highlighted:
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To Navigate to the Mailbox Details view:
1. From the AppInsight for Exchange Details view, click any user name within

a Mailbox resource, as highlighted:

.

Advanced Manual Configuration
AppInsight for Exchange's automated configuration tool makes adding this
application to a node simple. However, there may be times when you want to
manually configure available settings, permissions, and so on. Manual
configuration is only recommended for experienced Exchange administrators.

To Manually Configure Available Settings, refer to the following sections:
l Changes that will be made to enable AppInsight for Exchange
l Finding Exchange Credentials
l Manually Configuring Exchange Server
l AppInsight for Exchange Requirements and Permissions
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Chapter 19:
Monitoring Hardware Health
SAMmonitors hardware by polling nodes and utilizing the Hardware Monitoring
Agent software provided by the hardware manufacturer. SAM can monitor
hardware from VMware hosts, HP ProLiant, Dell PowerEdge, and the IBM X-
Series using this software, which can be found using the links below:

l HP System Insight Manager (SIM v6.2 or higher is recommended) †
l Dell OpenManage Server Administrator††
l IBM Director (Common Agent, v6.3 or higher is recommended) †††

SAM can also monitor the health of the following Server Blade Chassis without
the need for additional software:

l HP C7000 ‡

l HP C3000 ‡

l Dell M1000e ‡‡

Hardware monitoring is achieved by polling via SNMP or WMI, depending upon
the node. For SNMP and WMI nodes, hardware monitoring must be enabled
manually through SAM's web console. For more information, see "Adding Server
Hardware Monitoring" on page 837.

If you run a scheduled Network Sonar Discovery of your existing servers, SAM
will automatically collect any servers that support hardware health information the
next time the discovery runs. For more information, see: "Managing Scheduled
Discovery Results" on page 275

Monitoring your hardware's health does not count against your allotted licenses.

Note:Only SAM administrators can enable hardware health monitoring.
________________________

† HP Insight ManagementWBEMProviders for WindowsServer 2003/2008 is an optional component for
HPSystem Insight Manager that must be installed for SAM tomonitor hardware viaWMI. This component
can be found using the following link:

HP Insight ManagementWBEMProviders for WindowsServer 2003/2008

Additionally, youmayneed to install the HPProLiant Support Pack for Windows. This link can be found here:
HPProliant Support Pack
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Hardwaremonitoring hasbeen tested on HP's firmware versions7.50.0.0 and 7.51.0.0.

† †   Dell doesnot make arrayand hard disk health information visible fromWMImanaged nodes. Tomonitor storage
health on Dell servers, use SNMP. Hardwaremonitoring hasbeen tested on Dell'sOpenManage firmware versions
6.2.0, 6.3.0, 6.5.0, 7.0.0, and 7.1.0.
††† IBM'sServeRAID Manager must be installed on IBMX-Series servers for storage hardware health information to
be displayed in SolarWindsSAM. Installation instructions can be found using the following links:

IBM'sServeRAID ManagerMegaRAID StorageManagement Application (Optional: Only needed for MegaRAID
Controller support.)

Hardwaremonitoring hasbeen tested on IBM'sDirector Platform Agent 6.3.
‡Hardwaremonitoring hasbeen tested on HP'sBladeSystemOnboard Administrator 3.10.
‡‡Hardwaremonitoring hasbeen tested on Dell'sChassisManagement Controller (CMC) 3.01 and higher.

Hardware Items Monitored by SAM
l Fan status
l Power Supply status
l Temperature
l Disk status
l Battery status
l Array Controller status
l Physical Memory status
l Chassis Intrusion status
l CPU Temperature and/or status

Hardware Monitoring and VMware
Hardware monitoring is automatically enabled for VMware ESX and ESXi
servers. Monitoring of VMware servers uses the CIM protocol which should be
enabled by default after the installation of ESX/ESXi hosts. If installing Hardware
Monitoring Agent software on a VMware host, hardware information will be
detected by SAM and the check box to monitor Hardware Health of Servers will
be displayed, even where hardware information might already be collected via
the vCenter using the VMWare API. When this option is displayed for a VMware
host, checking it will not change the hardware polling method when Poll for
VMware is also selected.

If you are polling your hosts though the vCenter, you will not see the hardware
option listed when you click List Resources as these nodes tend to be ICMP.
This information is automatically collected by SAM, when available, through the
VMware API. You will need to ensure you have the vCenter Hardware Status
plug-in enabled on your V-Center for this information to be available though the
VMware API, as shown below: 
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Note: Port 5989 must be opened when polling VMware servers using the CIM
protocol.

If you run a scheduled Network Sonar Discovery of your existing servers, SAM
will automatically collect any servers that support hardware health information the
next time the scheduled discovery runs.

For more information, see:

l "Managing Scheduled Discovery Results" on page 275.
l "Virtualization" on page 319.

Accessing Hardware Monitoring Agent Software
Each vendor’s hardware monitoring agent software includes a web server that
operates on a unique port.

Note: Server Blade Chassis (HP C7000, HP C3000, and Dell M1000e) does not
use hardware monitoring agent software.

Navigating to https://{remote.ip.address}:{Port} successfully will validate that the
agent software is installed. Refer to the table below for the list of ports used by
each vendor:

Vendor: HP Dell IBM

Port: 2381† 1311 423††

For example: Navigating to https://10.186.16.100:1311 in your web browser will take
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you to the Dell OpenManage Server Administrator page on the remotely
monitored host.

___________________________________
† If HP Insight ManagementWBEMProviders for WindowsServer 2003/2008 is installed for HPSystem
Insight Manager, the Data Source in the SIMweb interface will read "WBEM." If this component is not
installed, the Data Source will read "SNMP."
†† The IBMDirector web-based access is an optional component for version 6.x and is not installed by
default.

For information on troubleshooting hardware health polling, see "Troubleshooting Hardware Health" on
page 1337.

Adding Server Hardware Monitoring
There are two ways for administrators to add server hardware monitoring for
nodes; through the Add Node wizard, and through the Node Details group of the
Node Details page.

Add Node Wizard

From the Add Node wizard, the option to display Hardware Health of Servers is
available after a node has been defined. Check this box to enable hardware
health monitoring.

Manually Add Hardware Monitoring

To add hardware health monitoring without using the Add Node wizard,
follow these steps:

1. Click the Home tab in the SAM web console.
2. In the All Nodes group, click the node you want to monitor.
3. In the Node Details group of the Node Details page, click the List

Resources button as shown below:
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The following screen appears:

Here you can select the available hardware you want to monitor by checking the
appropriate boxes and then clicking Submit.
To disable hardware monitoring, navigate back to this screen and uncheck
Hardware Health of Servers, then click Submit.
For information on troubleshooting hardware health polling, see "Troubleshooting
Hardware Health" on page 1337.

Hardware Details
Once you have chosen the hardware you want to monitor, the Hardware Health
Details group appears on the Node Details page and looks similar to the
following illustration, providing general information about your hardware and its
status:
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Note: This view will be hidden if hardware monitoring is disabled.

For more information, see " Current Hardware Health Status" on page 839.

For information on troubleshooting hardware health polling, see "Troubleshooting
Hardware Health" on page 1337.

Current Hardware Health Status
The current status of your hardware's health can be determined by the Current
Hardware Health grouping, as shown below. The status for most items will read
OK,Warning, or Critical, depending upon the set threshold values and the
returned values. The icon colors for each item will change between green, yellow,
and red, respectively. Gray icons indicate a status of Unknown, which suggests a
polling failure.

You can click on the [+] and [-] icons to expand and collapse a particular tree
branch of hardware that is being monitored. When collapsed, the top level view
(or roll-up status) of each hardware item will display the worst status of an item in
that branch.
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Note: The default temperature measurement is in degrees, Fahrenheit (ᵒF). To
change this to Celsius (ᵒC), from the web console, navigate to Settings >
Manage Accounts > Select Account > Edit. The Temperature Unit dropdown
menu can be found under the Server & Application Monitor Settings category.

Hardware Health Overview Chart
This resource provides a status overview of your monitored hardware's health.
Mousing over each pie segment will provide a tooltip with more detailed
information.
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Clicking a server icon in the Overview Chart will bring up a list of the servers with
the indicated status, as shown below. From here, you can navigate to the Details
page of each server by clicking any icon in the list.

Changing Threshold Values
Threshold values for each monitored item cannot be set within SAM; however,
some values can be configured through the Hardware Monitoring Agent Software
installed on your hardware. Dell OpenManage Server Administrator is one such
example. The illustration below shows how threshold values for the temperature
can be changed from the default values using Dell's software.
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Different default thresholds exist for different items in the Hardware Monitoring
Agent Software. Some of these thresholds may be accessible and open to
editing, some may not. Consult your Hardware Monitoring Agent Software user
guide for specific information about editing thresholds.

You can manually define alerting thresholds for any hardware sensor or category
in the Advanced Alert Manager.

For information, see:

l "Manually Changing Alert Thresholds" on page 846.
l "Accessing Hardware Monitoring Agent Software" on page 836.

Hardware Health Chart
This chart allows you to visualize multiple hardware statistics simultaneously.
The advantage of this view is that you can easily see how your hardware objects
are performing over a given period of time in relation to one another.

Tabs at the top of the chart allow you to quickly navigate between different groups
of hardware, allowing you to see the performance and status of an entire group of
the same hardware on a single page.
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Note: This view will be hidden if hardware monitoring is disabled.

Customizing the Hardware Health Chart
Click Edit at the top-right of the chart to be taken to the following screen. You can
customize the following user-specific aspects of the chart display:

l Sample Interval: This is the interval of time that will be displayed on the
chart.

l Title: This will give a title to display for your chart.
l Subtitle: This will give a subtitle to display for your chart.
l Temperature Display: This allows you to set the temperature units. This
will affect all charts that display temperature for the current user.
Note: For information on changing the measurement units between
Fahrenheit and Celsius, see "Server & Application Monitor Settings" on
page 308.
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l Time Period for Chart: This allows you to select the span of time the chart
will display.

Click Submit to save the settings.
Clicking the chart itself opens the following screen which allows you to edit
multiple, self-explanatory settings pertaining to the Hardware Chart.
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Click Submit to save the settings.
Note: The Raw Data button will deliver the chart data by downloading an Excel
spreadsheet. The Chart Data button displays the data in a web page.

For information on troubleshooting hardware health polling, see "Troubleshooting
Hardware Health" on page 1337.

Alerting on Hardware Health
SAM has the ability to create alerts on all aspects of monitored hardware. You
can access these alerts in the Advanced Alert Manager by navigating to the
Trigger Condition tab, then selecting either APM: Hardware, APM: Hardware
Type, or APM: Hardware Sensor from the Type of Property to Monitor
dropdown menu, as shown in the following illustration:
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For a list of hardware variables, see "Hardware Specific Variables" on page 964.

For information on Alerting and Reporting, see "Configuring SolarWinds SAM
Alerts" on page 722.

For information on troubleshooting hardware health polling, see "Troubleshooting
Hardware Health" on page 1337.

Manually Changing Alert Thresholds
You can manually define alerting thresholds for any hardware sensor or category
in the Advanced Alert Manager. The illustration below shows an example of how
to define an alert for when a fan's speed exceeds 3600 RPM.
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l For a list of hardware variables, see "Hardware Specific Variables" on
page 964.

l For information on Alerting and Reporting, see "Configuring SolarWinds
SAM Alerts" on page 722.

l For information on hardware health alerting, see "Alerting on Hardware
Health" on page 845.

l For information on troubleshooting hardware health polling, see
"Troubleshooting Hardware Health" on page 1337.
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l To manage and monitor real time processes, see "Real Time Process
Explorer" on page 848.

l To manage and monitor real time services, see "Service Control Manager"
on page 858.

l To manage and monitor scheduled tasks, sWindows Scheduled Task Mon-
itor

l To view and monitor real time events, see "Real Time Event Viewer" on
page 871.

Real Time Process Explorer
The Real Time Process Explorer (RTPE) is available for WMI and SNMP
monitored nodes. This feature is similar to the Processes tab found in the
Windows Task Manager. The advantage of the RTPE is that you no longer need
to physically, or remotely, log in to a particular computer and run the Task
Manager to retrieve that machine's vital statistics. Information for both monitored
and unmonitored processes is displayed directly through SAM using the RTPE.
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Notes:
l Only SAM administrators can end processes as well as enable and dis-
able the RTPE.

l The User Name and Command Line columns are hidden by default.
l Using the RTPE on a node monitored via ICMP, which has no working
component, will require you to select Windows credentials manually. Con-
sider promoting the selected node to SNMP or WMI to avoid this prompt.
For more information, see:

l "Promoting a Node from ICMP to SNMP Monitoring" on page 193.
l "Promoting a Node to WMI Monitoring " on page 195.

Accessing the Real Time Process Explorer
There are three places within SAM that you can access the RTPE: the Node
Details page, the Application Details page, and the Component Details page.

Node Details page

On the Node Details page, the Real-Time Process Explorer button can be found
at the bottom of each Top 10 list, as highlighted below:
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To navigate to the Node Details page:

1. Click the Home tab in the SAM web console.
2. In the All Nodes group, click a node.

Note: The Real-Time Process Explorer button will not be available on the Node
Details page in situations where Top 10 lists are hidden, or when an assigned
application template does not contain an SNMP Process Monitor or
WMI/Windows Service Monitor.

Clicking Real-Time Process Explorer will open the RTPE in a new window and
will be sorted by the Top 10 category. For example, clicking the Real-Time
Process Explorer button from the Top 10 Monitored Processes by CPU Load
category will open the RTPE window with the processes sorted by CPU usage.
The same is true for each Top 10 category.

Note: Pop-ups must be enabled in your browser to view the Real Time Process
Explorer.

Application Details page

The RTPE window can be accessed from the Application Details page, as
highlighted below:
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To navigate to the Application Details page:

1. Click the Home tab in the SAM web console.
2. In the All Applications group, click an Application.

Component Details page

On the Component Details page, the Real-Time Process Explorer button can be
found by the Management field, as highlighted in the following illustration:

To navigate to the Component Details page:

1. Click the Home tab in the SAM web console.
2. In the All Applications group, click an Application.
3. Click a component.

Monitoring Unmonitored Processes
Processes currently monitored by SAM are indicated by the application icon with
the name of the assigned application beside it. Processes that are not currently
monitored by SAM are indicated by the [+] symbol, followed by the words, Start
monitoring.
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To have SAMmonitor a process that is not being monitored:

1. Click Start monitoring.
2. From here, you will be taken to the Edit Properties section of the Com-

ponent Monitor Wizard. At this point, you can begin customizing the selec-
ted component monitor.

Using the Real Time Process Explorer
Different information is displayed in the RTPE depending on what protocol you
use to monitor a particular node. The table below shows the differences in the
information gathered based on the protocol used:

Available RTPE processes via:

Monitored Process: WMI SNMP

Name Yes Yes

Process ID Yes Yes

Assigned Application Yes Yes

CPU usage Yes Yes

Physical Memory Yes Yes

Virtual Memory Yes No

Disk I/O Yes No

User Name Yes No

Command Line Yes† Yes†

Polling interval Five seconds Up to two minutes

Notes:
l Windows servers do not update their SNMP statistics more frequently than
every two minutes. It takes at least two updates to these statistics to
provide an accurate calculation. This means data displayed in the RTPE
via SNMP can take up to four minutes to display. If this is unacceptable,
consider changing the protocol to WMI.

l SNMP uses significantly less bandwidth than WMI.
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____________________________________

† Information on certain processesmaynot be exposed which can result in certain rowsbeing blank.

Each column can be sorted by clicking the column head or hovering over the
column name and clicking the dropdown arrow. Columns can also be added or
removed this way. Each column can also be resized and/or re-arranged by
dragging the separators between each column head to change the width, or the
column heads themselves to change their position.

Note: By default, all available columns, with the exception of the User Name and
Command Line, are shown for the top ten running processes.

To show all running processes:

1. Click Show All at the bottom-left of the window.

To show a set number of running processes:

1. Change the number in the text box next to the Show All button from 10 to
any number that suits your needs.

To pause polling:

1. Click Pause Polling at the top-left of the window when available.

To end processes:

1. Check the boxes next to the processes you want to end and then click End
Process.
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Note: This option is only available when the RTPE is using a WMI con-
nection.

To start polling:

1. Click Start Polling at the top-left of the window.

For Windows based nodes, you can change the credentials used by clicking the
Use Different Credentials button to bring up the credential library dialog box.

Clicking Refresh will re-poll the running processes.

Real Time Process Explorer Alerts
Three alerts are included with the Real Time Process Explorer:

l High CPU Percent Utilization with Top 10 Processes. (This alert will
send an email when the CPU utilization is greater than 80%.)

l High Physical Memory Utilization with Top 10 Processes. (An alert will
be sent when physical memory usage is at or above 90%.)

l High Virtual Memory Utilization with Top 10 Processes. (An alert will be
sent when virtual memory usage is at or above 90%.)

These alerts can be found in the Alert Manager as highlighted in the following
illustration:
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As with all alerts, these three can be customized to suit your needs by selecting
an alert via the check box and clicking the Edit button. For more information, see
"Adding Alert Actions" on page 754.

Note: Alerts may lag if you are monitoring hardware via SNMP. It takes at least
two updates to these statistics to provide an accurate calculation, meaning an
alert can take up to four minutes to reach its recipient. If this is unacceptable,
consider changing the protocol to WMI, which updates every five seconds. Also
consider adjusting the trigger time to a value greater than two minutes. For more
information, see "Using the Real Time Process Explorer" on page 852.

Real Time Process Information in Top XX Alerts
SAM provides additional troubleshooting information for high CPU, memory, and
virtual memory by sending email alerts. This is done by utilizing the Top
Offending Processes metric running on the server at the time of the alert.

To edit an alert:

1. Open the Alert Manager  by navigating to Start > SolarWinds Orion >
Advanced Alert Manager.

2. Click Configure Alerts.
3. Highlight a hardware alert from the list and then click Edit.
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4. Click the Trigger Actions tab.
5. Highlight Execute Program… and then click Edit.
6. Click the Execute Program tab as shown below:

Following is the path where the executable
SolarWinds.APM.RealTimeProcessPoller.exe is located along with its command line
arguments:
C:\Program Files (x86)\SolarWinds\Orion\APM\
SolarWinds.APM.RealTimeProcessPoller.exe

Command line argument syntax:

SolarWinds.APM.RealTimeProcessPoller.exe -n=<NodeID> [-count=<NumberOfProcesses>]
[-sort=<SortBy>] [-timeout=<PollingTimeout>] [-alert=<AlertDefID>]

Command line argument variables:

Variable Definition Definition

-n Defines the ID of a Node (NodeID), which
will be polled.

-count Defines the number of processes to show.

-sort Defines the criteria to use for the selection
of top processes. Possible values:
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Process

CPU Processor time. This is the
default value if the com-
mand line argument isnot
specified.

PhysicalMemory Process physical memory.

VirtualMemory Process virtual memory.

DiskIO Process disk I/O per
second.

-timeout Defines timeout for polling in seconds.

-alert Defines AlertDefID of associated triggered
alert. If this argument is provided, then alert
notes are updated with the results from
polling.

-act-
iveObject

Defines the ActiveObject property of the
associated triggered alert. If this argument
is not provided, NodeID is used.

Example 1:
This example will return the top 20 processes with the highest virtual
memory consumption running on the host with node ID 123.
SolarWinds.APM.RealTimeProcessPoller.exe -n=123 -count=20 -
sort=VirtualMemory -timeout=300

Example 2:
This example uses the Execute an External Program alert action:
SolarWinds.APM.RealTimeProcessPoller.exe  -n=${NodeID} -alert=${AlertDefID}

Example 3:
This example uses the Execute an External Program alert action for an alert
defined for the Volume object type
SolarWinds.APM.RealTimeProcessPoller.exe -n=${NodeID} -alert=${AlertDefID} -
activeObject=${NetObjectID} -sort=VirtualMemory
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Service Control Manager
The Service Control Manager (SCM) is similar to the Real Time Process
Explorer, with the main difference being that it allows you to manage the services
of monitored Windows nodes, as opposed to processes. The advantage of the
SCM is that you no longer need to physically, or remotely, log in to a particular
Windows computer to view and control its services. Information for both running
and stopped services is displayed directly through SAM using the Service Control
Manager.

Note: Services viewed in the Service Control Manager are polled every 25
seconds using WMI.

Accessing the Service Control Manager
There are four places within SAM that you can access the SCM: the Application
Details page, the Component Details page, the Node Details, and the
Management Resource page.

Application Details page

On the Application Details page, the Service Control Manager button can be
found at the top of the Application Details resource, as highlighted below:
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To navigate to the Application Details page:

1. Click the Home tab in the SAM web console.
2. In the All Applications group, click an Application.

Note: Pop-ups must be enabled in your browser to view the Service Control
Manager.

Component Details page

On the Component Details page, the Service Control Manager button can be
found at the top of the Component Details resource, as highlighted below:

To navigate to the Application Details page:
1. Click the Home tab in the SAM web console.
2. In the All Applications group, click an Application.
3. Click a component.

Node Details page

On the Node Details page, the Service Control Manager button can be found at
the bottom of each Top 10 list, as highlighted below:
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To navigate to the Node Details page:

1. Click the Home tab in the SAM web console.
2. In the All Nodes group, click a node.

Note: The Service Control Manager button will not be available on the Node
Details page in situations where Top 10 lists are hidden. Clicking Service Control
Manager will open the SCM in a new window and the services will be sorted
alphabetically.

Note: Pop-ups must be enabled in your browser to view the Service Control
Manager.

Management Resource
On the Node Details page, the Service Control Manager button can be found in
the Management resource, as highlighted below:

Using the Service Control Manager
The Service Control Manager (SCM) shows all the services, running or not, that
are on the monitored computer. Hovering the mouse over the row of any service
will give you detailed information about that service in a tool tip, as shown below:
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Starting and Stopping a Service:

1. Click the row of a service to select it.
2. At the top of the window, Select either Stop Service, Start Service or

Restart service.
Services currently monitored by SAM are indicated by the application icon with
the name of the assigned application beside it. Services that are not currently
monitored by SAM are indicated by the [+] symbol, followed by the words, Start
monitoring this service.

To Monitor a Service with SAM:
1. Click Start monitoring this service in the row of the service you want to

monitor.
2. From here, you will be taken to the Edit Properties section of the Com-

ponent Monitor Wizard wizard. At this point, you can begin customizing the
selected component monitor.

Once the Service Control Manager is activated, each column can be sorted by
clicking the column head or hovering over the column name and clicking the
dropdown arrow. Columns can also be added or removed this way. Each column
can also be resized and/or re-arranged by dragging the separators between each
column head to change the width, or the column heads themselves to change
their position.

The table below shows the default settings for the Service Control Manager:

Action Description Default
Setting

Service Job
Life Time

This is used to specify how long the information
for a service exists.

3
minutes

Service Poll
Interval

This is used to specify the refresh frequency of the
information reported by the service.

25
seconds

Service Action
Job Timeout

This reports the timeout for a service. 3
minutes

Note: By default, all available columns are shown.
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Windows Scheduled Task Monitor
The Windows Scheduled Task Monitor (WSTM) is a resource designed to
provide you with quick visual access to the status of scheduled tasks configured
on your Windows nodes.

The WSTM comes with an alert which will notify you of any task execution
failures, as well as web based reports that allow you to view all scheduled tasks
configured across all servers in your environment. Additionally, there is a
dedicated Task Failure Report you can view or have emailed to you on a regular
basis.

Note: This resource is hidden when the WSTM is not being monitored on a node.

For more information, refer to the following sections:
l Requirements for the Windows Scheduled Task Monitor
l Enabling the Windows Scheduled Task Monitor
l Accessing the Windows Scheduled Task Monitor
l Understanding the Windows Scheduled Task Monitor
l Alerting Using Windows Scheduled Task Monitor Macros

Requirements for the Windows Scheduled Task Monitor
The WSTM supports monitoring tasks on the following operating systems:

• Windows 2003

• Windows 2003 R2

• Windows 2008

• Windows 2008 R2

• Windows 2012
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• Windows 2012 R2

Notes:
l When SAM is installed on Windows 2003 or 2003 R2, scheduled tasks on
Windows 2008 or later cannot be polled by the Windows Scheduled Task
Monitor (WSTM).

l The WSTM consumes five license units per node.

Enabling the Windows Scheduled Task Monitor
There are several locations available that allow you to enable the WSTM:

l When adding a new WMI managed node.
l When listing resources on an existing WMI managed node.
l When employing the Network Sonar Discovery Wizard. (Both one-time dis-
covery, and scheduled discovery options are available using this method.)

Notes:
l TheWindows Scheduled Tasks option is hidden when a task is not found
on the target machine.

l TheWindows Scheduled Tasks option is unchecked by default when at
least one task is found on the target machine.

l TheWindows Schedule Tasks option is checked when tasks are already
being monitored.

To enable the WSTM via adding a WMI managed node:
1. From the web console, navigate to Settings > Manage Nodes.
2. Click [+] Add Node.
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3. Select theWindows Servers: WMI and ICMP option and enter the proper
credentials.

4. Click Next.
5. CheckWindows Scheduled Tasks.

To enable the WSTM via listing the resources of a WMI managed node:
1. From the web console's Home tab, find the All Nodes resource.
2. Expand the Windows tree by clickingWindows.
3. Click a Windows node to be taken to the Node Details page for that node.

4. From the Management resource, click List Resources, as shown:
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5. CheckWindows Scheduled Tasks, and then click Submit.

To enable the WSTM via Network Sonar Discovery:
1. From the web console, click Settings in the upper right-hand corner of the

screen.
2. In the Getting Started with Orion grouping, click Network Sonar Dis-

covery.
3. Continue through the wizard.
4. When prompted, on the Scheduled Discovery Results tab, checkWindows

Scheduled Tasks, as highlighted, and then click Submit:

Accessing the Windows Scheduled Task Monitor
When monitored, you will find the Windows Schedule Task Monitor resource only
on the Node Details view of the monitored server.

To view the WSTM on the Node Details page:
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1. From the web console's Home tab, find the All Nodes resource.
2. Expand the Windows tree by clickingWindows.
3. Click a Windows node to be taken to the Node Details page for that node.
4. On the Node Details page, find theWindows Scheduled Task resource, as

shown:

Note: The WSTM is not shown in the All Applications resource.

Understanding the Windows Scheduled Task Monitor

The WSTM has four columns that provide the following information:

l Task Name: This column displays the detailed name of the scheduled task.
l Status: This displays the current status of the listed task.
l Last Run Time: This displays the last time the listed task executed.
l Last Run Result: This displays the result of the listed task's last execution
as an icon.

Tips:
l Hovering over any item in the Task Name column will provide a tooltip with
detailed information about the listed task.

l You can sort the display by clicking the head of each column.
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l Clicking >>Edit Settings at the bottom of the resource will allow you to:
l Change the polling frequency.
l Change the polling timeout period.
l Change credentials.
l Add custom notes.

Alerting Using Windows Scheduled Task Monitor Macros
The following variables are associated with the Windows Scheduled Task
Monitor and can be used in alerting:

l ${WindowsScheduledTaskDetailsURL}
l ${ApplicationID}
l ${Author}
l ${DateOfCreation}
l ${Description}
l ${ID}
l ${LastRunResult}
l ${LastRunTime}
l ${Name}
l ${NextRunTime}
l ${NodeID}
l ${TaskState}

These variables can be found in the Advanced Alert Manager by navigating to
Start > SolarWinds Orion > Advanced Alert Manager.
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Following is an example email using alert macros with the Windows Scheduled
Task Manager:

Subject:
Scheduled Task ${Name} on ${Node.Caption} had an unsuccessful
last run.

Body:
The Windows Scheduled Task ${Name} on server ${Node.Caption}
reports ${LastRunResult}. The task executed on ${LastRunTime} and
is scheduled to run again ${NextRunTime}.

<br>

Task Description: ${Description}.
Task Creation Date: ${DateOfCreation}.
Task Author: ${Author}.

For more information on the status of this task, click:
${APMWstm:TaskDetailsURL}.

WSTM Alerts
The following is a list associated with the WTSM:

l Windows Scheduled Tasks: Alert me when the task last run result is non-
successful.
Note: By default, this alert is disabled.

For more information, see Creating Alerts

Windows Scheduled Task Monitor Returned Status Codes
Following is a list of status codes and their meanings that may appear in the
WSTM resource:

Hex Status
Code

Description

(0x0) The operation completed successfully.

(0x1) Incorrect or unknown function called.

(0x2) File not found.
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(0xA) The environment is incorrect.

(0x41300) The task is ready to run at its next scheduled time.

(0x41301) The task is currently running.

(0x41302) The task will not run at the scheduled times because it has
been disabled.

(0x41303) The task has not yet run.

(0x41304) There are no more runs scheduled for this task.

(0x41305) One or more of the properties that are needed to run this task
on a schedule have not been set.

(0x41306) The last run of the task was terminated by the user.

(0x41307) Either the task has no triggers or the existing triggers are
disabled or not set.

(0x41308) Event triggers do not have set run times.

(0x4131B) The task is registered, but not all specified triggers will start
the task.

(0x4131C) The task is registered, but may fail to start. Batch logon
privilege needs to be enabled for the task principal.

(0x41325) The Task Scheduler service has asked the task to run.

(0x8004020D) Cannot modify or delete an object that was not added using
the COM+ Admin SDK.

(0x80041309) A task's trigger is not found.

(0x8004130A) One or more of the properties required to run this task have
not been set.

(0x8004130B) There is no running instance of the task.

(0x8004130C) The Task Scheduler service is not installed on this computer.

(0x8004130D) The task object could not be opened.

(0x8004130E) The object is either an invalid task object or is not a task
object.
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(0x8004130F) No account information could be found in the Task Scheduler
security database for the task indicated.

(0x80041310) Unable to establish existence of the account specified.

(0x80041311) Corruption was detected in the Task Scheduler security
database; the database has been reset.

(0x80041312) Task Scheduler security services are available only on
Windows NT.

(0x80041313) The task object version is either unsupported or invalid.

(0x80041314) The task has been configured with an unsupported
combination of account settings and run time options.

(0x80041315) The Task Scheduler Service is not running.

(0x80041316) The task XML contains an unexpected node.

(0x80041317) The task XML contains an element or attribute from an
unexpected namespace.

(0x80041318) The task XML contains a value which is incorrectly formatted
or out of range.

(0x80041319) The task XML is missing a required element or attribute.

(0x8004131A) The task XML is malformed.

(0x8004131D) The task XML contains too many nodes of the same type.

(0x8004131E) The task cannot be started after the trigger end boundary.

(0x8004131F) An instance of this task is already running.

(0x80041320) The task will not run because the user is not logged on.

(0x80041321) The task image is corrupt or has been tampered with.

(0x80041322) The Task Scheduler service is not available.

(0x80041323) The Task Scheduler service is too busy to handle your
request. Please try again later.

(0x80041324) The Task Scheduler service attempted to run the task, but the
task did not run due to one of the constraints in the task
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definition.

(0x80041327) The task has properties that are not compatible with earlier
versions of Windows.

(0x80041328) The task settings do not allow the task to start on demand.

(0x80070002) The system cannot find the file specified.

(0x800700C1) Not valid Win32 application.

(0x800704C7) The operation was canceled by the user.

(0x800704DD) The operation being requested was not performed because
the user has not logged on to the network. The specified
service does not exist.

(0xC000013A) The application terminated.

(0xC06D007E) Unknown software exception.

For a complete list of error codes, see http://msdn.microsoft.com/en-
us/library/windows/desktop/aa383604%28v=vs.85%29.aspx

Real Time Event Viewer
The Real Time Event Viewer (RTEV) allows you to view Windows event logs in
real time using the WMI protocol. Event logs can be filtered by log type, event
source, and the level of severity. You can also select which event logs you want
to monitor from within this resource.
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Accessing the Real Time Event Viewer
The RTEV is accessible from the Management resource found on the Node
Details page and the Application Details page, as shown below. It is also
available on the Component Details view of the Windows Event Log component,
as well as from every component within an application assigned to a node
recognized as being Windows.

To navigate to the Node Details page:

1. Click the Home tab in the SAM web console.
2. In the All Nodes group, click a node.

To navigate to the Application Details page:

1. Click the Home tab in the SAM web console.
2. In the All Applications group, click an application.

To navigate to the Component Details page:

1. Click the Home tab in the SAM web console.
2. In the All Applications group, click an application.
3. Click the Windows Event Log component (if available).

Filtering Events
Different events are displayed in the RTEV depending upon the log type and
filters you choose.

Once you select a Log Type from the dropdown list, SAM will immediately begin
collecting these logs and display them in the message window to the right, as
shown:
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To Select a Log Type:

1. Select a Log Type from the drop down menu.

Once  the events of the selected Log Type are collected and displayed in the right
window, you can filter the results with various criteria.

To Filter Collected Events:
1. Select Custom Sources from the Event Sources dropdown menu.
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2. Check only the sources you want to keep when the filter is applied, as high-
lighted below:

3. Select the type of messages you want the filter to keep by checking the
appropriate Event Level check boxes. (Note that the icons in this legend
correspond to messages in the display window.)

4. Click Apply Filter to have the events filtered and displayed.
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Reading Events
Once filtering is complete, you can hide and unhide the filtering pane on the left
by clicking either of the two arrows, highlighted in red:

The display window shows a list of the most recent events. Should any new
events occur while this window is open, a green bar at the top of the window will
indicate that new events have arrived, as shown in the above image. You can
click the green bar to add these new events to the display window.

Note: The Level column icons correspond to the Event Level icons in the legend
of the events pane.

Clicking on any message in the display window will bring up a message box
providing the entire message along with additional details, as shown:

Monitoring Events
There are three ways to begin monitoring events from within the RTEV:

l Click Start Monitoring in the Message Details view.
l Click [+] Start Monitoring in the Assigned Application column in the row
of the event you want to monitor.

l Select multiple events from the list window by checking the appropriate
boxes and then click [+] Start Monitoring at the top of the window.

All three methods (highlighted below) will take you to the Add Component Monitor
wizard and allow you to create an application based on your selection.
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Component Monitor Wizard

Once you begin the Component Monitor Wizard, you will encounter the option to
Disable Keyword Matching.

This dropdown menu will help you better filter the results you want.
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